Legal notices

The information contained herein is subject to change without notice.

The only warranties for HP products and services are set forth in the express warranty statement accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

IPv6-ready

Trademarks

Adobe®, Acrobat®, and Adobe Photoshop® are trademarks of Adobe Systems Incorporated.

ENERGY STAR and the ENERGY STAR mark are registered U.S. trademarks.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Apple and AirPrint are trademarks of Apple Inc., registered in the U.S. and other countries.

Wi-Fi certified
# Table of contents

1 Introduction .......................................................................................................................... 1
   Safety precautions .................................................................................................................. 1
   Using this guide ..................................................................................................................... 2
   Printer models ....................................................................................................................... 3
   Main features ........................................................................................................................ 4
   Main components .................................................................................................................. 4
   Turn the printer on and off ................................................................................................. 7
   Front panel ............................................................................................................................ 7
   Printer solutions .................................................................................................................... 9
   Mobile Printing ..................................................................................................................... 11
   Enable email printing .......................................................................................................... 11
   Reports .................................................................................................................................. 11

2 Connecting the printer .......................................................................................................... 13
   Choose which connection method to use ............................................................................ 13
   1. Connect the printer to your network ............................................................................... 14
   2. Set up your device ............................................................................................................ 15
   Other options ....................................................................................................................... 15

3 Setting up the printer .......................................................................................................... 17
   Introduction .......................................................................................................................... 17
   Automatic firmware update ................................................................................................. 17
   Turn email notifications on and off .................................................................................... 17
   Turn alerts on and off ......................................................................................................... 17
   Control access to the Embedded Web Server .................................................................... 19
   Set Windows driver preferences ......................................................................................... 19

4 Personalizing the printer .................................................................................................... 20
   Change the language of the front-panel display ................................................................. 20
   Access the Embedded Web Server ..................................................................................... 20
   Change the language of the Embedded Web Server .......................................................... 20
   Access the HP Utility (Windows only) ................................................................................ 21
   Change the language of the HP Utility ............................................................................... 21
   Change the sleep mode setting ........................................................................................... 21
   Configure power button mode ........................................................................................... 21
   Change the auto-off setting ............................................................................................... 21
Change the front-panel display brightness ................................................................. 22
Configure network settings ...................................................................................... 22
Configure firewall settings ...................................................................................... 23
Embedded Web Server security settings ................................................................. 24

5 Paper handling ....................................................................................................... 26
General paper-loading advice .................................................................................. 26
Load a roll onto the spindle ..................................................................................... 26
Load a roll into the printer ....................................................................................... 27
Unload a roll ............................................................................................................ 28
Load a single sheet .................................................................................................. 28
Unload a single sheet .............................................................................................. 29
Use the multi-sheet tray ......................................................................................... 29
View information about the paper .......................................................................... 30
Maintain paper ......................................................................................................... 31
Change the drying time ......................................................................................... 31
Turn the automatic cutter on and off .................................................................... 31
Form feed and form feed and cut ......................................................................... 32

6 Printing .................................................................................................................. 33
Mobile Printing ....................................................................................................... 33
Print using Wi-Fi Direct ......................................................................................... 34
Easy printing with HP Click ................................................................................... 36
Printing from an application using a printer driver ............................................... 37

7 Practical printing examples .................................................................................. 43
Print a draft for revision with the correct scale ...................................................... 43
Print a PDF multipage job from Adobe Acrobat Reader or Adobe Acrobat Pro .... 43
Print a document with the correct colors ............................................................... 44
Print a project using Autodesk AutoCAD ............................................................... 48
Print a presentation ................................................................................................. 50
Print and scale from Microsoft Office .................................................................... 52

8 Handling ink cartridges and printhead ............................................................... 54
About the ink cartridges ......................................................................................... 54
Storage of anonymous usage information ............................................................. 54
Check ink cartridge status ..................................................................................... 54
Replace an ink cartridge ....................................................................................... 55
About the printhead ............................................................................................... 56
Safe mode ............................................................................................................... 56
9 Maintaining the printer .......................................................................................................................... 58
  Check printer status ................................................................................................................................. 58
  Take care of the printer ............................................................................................................................. 58
  Clean the exterior of the printer ............................................................................................................... 58
  Print Quality Diagnostic Report .............................................................................................................. 58
  Clean the printhead ................................................................................................................................. 59
  Align the printhead ................................................................................................................................. 60
  Replace the printhead ............................................................................................................................. 61
  Clean the encoder strip ............................................................................................................................ 63
  Recalibrate the paper advance ............................................................................................................... 64
  Move or store the printer ......................................................................................................................... 65
  Firmware update ....................................................................................................................................... 65
  Software update ........................................................................................................................................ 65
  Printer maintenance kits ......................................................................................................................... 65
  HP Support Assistant ............................................................................................................................... 66

10 Accessories ............................................................................................................................................ 67
  How to order supplies and accessories ................................................................................................. 67
  Introduction to the accessories ............................................................................................................... 68

11 Troubleshooting paper issues ............................................................................................................. 69
  Paper cannot be loaded successfully ....................................................................................................... 69
  Paper type is not in the driver ................................................................................................................... 71
  Printer printed on the wrong paper type ................................................................................................. 72
  Paper mismatch ......................................................................................................................................... 73
  Roll has jammed ......................................................................................................................................... 73
  Prevent a jam ............................................................................................................................................... 74
  Multi-sheet tray has jammed ..................................................................................................................... 75
  A strip stays on the output tray and generates jams .............................................................................. 77
  Printer displays out of paper when paper is available .......................................................................... 77
  Prints do not fall neatly into the bin ......................................................................................................... 77
  Sheet stays in the printer when the print has been completed ............................................................... 77
  Paper is cut when the print has been completed .................................................................................... 78
  Cutter does not cut well ............................................................................................................................ 78
  Roll is loose on the spindle ...................................................................................................................... 78

12 Troubleshooting print-quality issues ................................................................................................ 79
  General printing advice ............................................................................................................................ 79
  Horizontal lines across the image (banding) ............................................................................................ 79
  Lines are too thick, too thin or missing .................................................................................................... 80
Lines appear stepped or jagged ................................................................. 80
Lines print double or in the wrong colors ............................................... 80
Lines are discontinuous ........................................................................ 81
Lines are blurred ................................................................................... 81
Line lengths are inaccurate ..................................................................... 82
Whole image is blurry or grainy ............................................................. 82
Paper is not flat ....................................................................................... 83
Print is scuffed or scratched ................................................................... 83
Ink marks on the paper ........................................................................... 84
Black ink comes off when you touch the print ...................................... 84
Edges of objects are stepped or not sharp .............................................. 84
Edges of objects are darker than expected ........................................... 85
Vertical lines of different colors ......................................................... 85
White spots on the print ......................................................................... 85
Colors are inaccurate ............................................................................ 85
Colors are fading .................................................................................. 86
Image is incomplete (clipped at the bottom) ........................................ 86
Image is clipped .................................................................................... 86
Some objects are missing from the printed image ............................... 87
If you still have a problem ..................................................................... 87

13 Troubleshooting ink cartridge and printhead issues .......................... 88
  Cannot insert an ink cartridge .............................................................. 88
  Ink cartridge status messages ............................................................. 88
  Cannot insert the printhead ................................................................. 88

14 Troubleshooting data communication issues .................................... 89
  Communication failures between computer and printer .................. 89
  Wired network issues ........................................................................ 90
  Wireless network issues ................................................................... 90
  Mobile Printing issues ....................................................................... 93
  Network configuration page ............................................................... 93

15 Troubleshooting general printer issues ............................................. 95
  Printer does not start ......................................................................... 95
  Printer does not print ......................................................................... 95
  Printer seems slow ............................................................................ 95
  Front panel is frozen .......................................................................... 96
  Cannot access the Embedded Web Server ....................................... 96
  Restore factory defaults and settings ................................................. 96
Alerts ........................................................................................................................................................................... 97

16 Front-panel error messages .................................................................................................................................................. 98
Text messages and numerical error codes .................................................................................................................................... 98

17 HP Customer Care .............................................................................................................................................................................. 100
Introduction .................................................................................................................................................................................. 100
HP Professional Services ................................................................................................................................................................. 100
Customer Self Repair ...................................................................................................................................................................... 101
Contact HP Support ........................................................................................................................................................................ 101

18 Printer specifications ........................................................................................................................................................................ 103
Functional specifications ................................................................................................................................................................. 103
Mobile Printing specifications ............................................................................................................................................................. 104
Physical specifications ........................................................................................................................................................................ 105
Memory specifications ....................................................................................................................................................................... 105
Power specifications ........................................................................................................................................................................... 105
Ecological specifications ................................................................................................................................................................. 106
Environmental specifications ............................................................................................................................................................ 106
Acoustic specifications ..................................................................................................................................................................... 106

Glossary ............................................................................................................................................................................................................ 107

Index ............................................................................................................................................................................................................... 110
1 Introduction

Essential safety precautions and an overview of the printer’s main features, components, software options and printing possibilities.

Safety precautions

Ensure proper use of the printer to prevent the printer from being damaged.

Follow these precautions at all times:

- Use the power supply voltage specified on the label. Avoid overloading the printer’s electrical outlet with multiple devices.
- Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for service, see HP Support Center on page 100.
- Use only the electrical cord supplied by HP with the printer. Do not damage, cut, or repair the power cord. A damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-approved power cord.
- Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the printer. Doing so may cause fire, electric shock, or other serious hazards.
- For printers without a stand:
  - Use a support strong enough to hold at least twice the total combined weight of the printer, supplies, and accessories.
  - Ensure the printer fits fully within the support’s surface.
  - Ensure that the support is used exclusively for the printer.
  - Ensure that all the printer rubber bearings are located fully within the support’s surface.
  - Follow the assembly instructions that came with the printer, and keep them available to ensure safe usage.
- Power off the printer and unplug the power cord from the power outlet in any of the following cases:
  - When placing your hands inside the printer
  - If there is smoke or an unusual smell coming from the printer
  - If the printer is making an unusual noise not heard during normal operation
● A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of the printer
● During an electrical storm (thunder and lightning)
● During a power failure

Using this guide

This guide can be downloaded from the HP Support Center.

Introduction

This is a brief introduction to the printer and its documentation for new users.

Use and maintenance

To help you carry out normal printer procedures.
Topics include the following:
● Connecting the printer on page 13
● Setting up the printer on page 17
● Personalizing the printer on page 20
● Paper handling on page 26
● Printing on page 33
● Mobile Printing on page 33
● Practical printing examples on page 43
● Handling ink cartridges and printhead on page 54
● Maintaining the printer on page 58

Troubleshooting

To help you solve problems that may occur while printing.
Included are the following topics:
● Troubleshooting paper issues on page 69
● Troubleshooting print-quality issues on page 79
● Troubleshooting ink cartridge and printhead issues on page 88
● Troubleshooting data communication issues on page 89
● Troubleshooting general printer issues on page 95
● Text messages and numerical error codes on page 98
Accessories, support and specifications

Reference information, including customer care, the printer specifications, and part numbers for paper types, ink supplies, and accessories.

Accessories on page 67, HP Customer Care on page 100, and Printer specifications on page 103.

Glossary

The glossary contains definitions of printing and HP terms used in this documentation.

Glossary on page 107.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and cautions

Symbols are used in this manual to ensure the proper use of the printer and to prevent the printer from being damaged.

Follow the instructions marked with these symbols:

⚠️ **WARNING!**  Failure to follow the guidelines marked with this symbol could result in serious personal injury or death.

⚠️ **CAUTION:**  Failure to follow the guidelines marked with this symbol could result in minor personal injury or damage to the printer.

Printer models

This guide covers various printer models. There may be slight differences depending on the model.

Printer models are normally referred to by their short names for brevity:

<table>
<thead>
<tr>
<th>Full name</th>
<th>Short name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T210 24-in Printer</td>
<td>T210</td>
</tr>
<tr>
<td>HP DesignJet T230 24-in Printer</td>
<td>T230</td>
</tr>
<tr>
<td>HP DesignJet T250 24-in Printer</td>
<td>T250</td>
</tr>
<tr>
<td>HP DesignJet T630 24-in Printer</td>
<td>T630-24</td>
</tr>
<tr>
<td>HP DesignJet T650 24-in Printer</td>
<td>T650-24</td>
</tr>
<tr>
<td>HP DesignJet T630 36-in Printer</td>
<td>T630-36</td>
</tr>
<tr>
<td>HP DesignJet T650 36-in Printer</td>
<td>T650-36</td>
</tr>
</tbody>
</table>

⚠️ **NOTE:** The images appearing in this User Guide may not look the same as the printer you have.
Main features

HP DesignJet T200/T600 Printer series are four color inkjet printers, designed to deliver CAD / Construction drawings as well as high quality graphics.

Paper up to 610 mm (24 in) or 914 mm (36) wide can be used to print on. Some major features of the printer are shown below:

- Print resolution of up to 2400 × 1200 dpi using the Best print-quality option, the Maximum Detail option and photo paper
- The printer can be controlled from its front panel or from a remote computer using the Embedded Web Server, HP DesignJet Utility*. It can also be controlled from your tablet, or from your mobile device with the HP Smart App.
- Handles roll and cut-sheet paper, with a multi-sheet tray which automatically switches between both*
- Touch-sensitive front panel in color, with an intuitive graphical user interface
- Supports USB, Ethernet, or Wi-Fi connection
- Includes Web-connected features such as automatic firmware upgrades
- Supports remote printing from mobile devices with HP Smart App, see http://www.hpsmart.com
- Economode for printing economically
- Enables easy printing from desktop with HP Click, see http://www.hp.com/go/designjetclick
- Ink and paper usage information available from the Embedded Web Server, see Access the Embedded Web Server on page 20
- Supplies information, troubleshooting, and firmware updates available from the HP Utility, see Access the HP Utility (Windows only) on page 21
- Access to the online HP Support Center, see HP Support Center on page 100
- HP Support Assistant supports the printer, see HP Support Assistant on page 66
- Compatible with the HP Applications Center – Poster App, see http://www.hpapplicationscenter.com

*Windows only

* Multi-sheet tray included in HP DesignJet T600 and available as accessory for HP DesignJet T200 Printer series

Main components

Hardware features of your printer.

Front view (T600 Printer series)

Overview of the front of the printer's main hardware components.
1. Multi-sheet tray
2. Front panel
3. Main door
4. Ink cartridges
5. Carriage
6. Stand

**Rear view (T600 Printer series)**

Overview of the back of the printer's main hardware components.
1. Paper roll
2. Communication ports
3. Fast Ethernet port, to connect to a network
4. Speed USB device port, to connect a computer
5. Power button
6. Power socket
7. Multi-sheet tray

**Rear view (T200 Printer Series)**

Overview of the back of the printer’s main hardware components.

*NOTE:* The multi-sheet tray is an accessory for this model.
1. Blue stop
2. Spindle
3. Paper roll
4. Fast Ethernet port, to connect to a network
5. Speed USB device port, to connect a computer
6. Power button
7. Power socket

**Turn the printer on and off**

The power key is located at the back of the printer.

The power key can also be used to put the printer into sleep mode. See *Configure power button mode* on page 21. The key is illuminated when the printer is on. It flashes when the printer is in transition between on and off.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are recommended to unplug the power cord.
To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printhead.

**NOTE:** When the printer has not been used for a certain period of time (the default time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer’s front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To change the sleep mode time, see Change the sleep mode setting on page 21.

**Front panel**

Located on the front left of the printer there is a touch-sensitive screen with a graphical user interface. From it, you can print, view information, change settings, and perform calibrations and tests, etc.

The front panel also displays alerts (warning and error messages) when needed.

1. **Dashboard icons**

The front panel dashboard lets you access the icons on the display, check the status of the printer, or monitor and manage current and scheduled printer tasks.

Tap or swipe down the tab at the top of a screen to open the dashboard:

- Tap to change printer settings.
- Tap to view ink information.
- Tap to view printhead information.
• Tap to view connectivity status information and to perform network configuration. If a network cable is connected, is displayed instead.

**NOTE:** It is not possible to use wireless and wired network connections simultaneously.

• Tap to view information about Wi-Fi Direct.

• Tap to view information and configure ePrint to print from a computer or mobile device, sending an email to the printer.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. See how to configure the power management: Configure power button mode on page 21.

2. Home screen dynamic icons

The front panel has a central area to display dynamic information and icons.

The following items are displayed when you tap the paper icon:

• Tap to load, unload, and change options for roll paper.

• Tap to change options for the multi-sheet tray, or to activate it.

• Tap to load, unload, and change options for single sheets.

To change the printer settings or print reports, use the options available in:

**NOTE:** The active paper source is indicated by a slightly larger icon, with a white tick in a green circle:

3. Fixed icons

On the lower side of the screen up to 3 fixed icons can be seen at different times. Normally they are not all displayed at the same time.

• Tap to return to the home screen.

• Tap to view help about the current screen.

• Tap to go back to the previous screen without discarding changes.

Printer solutions

Drivers and other tools are provided with your printer to raster, review, print locally/remotely, and access support if required.


• Driver for Windows and Mac
• The HP DesignJet driver that offers a preview, which enables you to see a basic preview of how your job will print.

• The Embedded Web Server that allows you to manage the printer from a remote computer, update the printer’s firmware and change various printer settings, etc.

See Access the Embedded Web Server on page 20.

• The HP Utility (Windows only) that allows you to manage the printer from a remote computer:

See Access the HP Utility (Windows only) on page 21.

**NOTE:** New versions of all printer software can be expected to appear from time to time. In some cases, when you receive your printer there may already be later versions available on HP’s website of some of the software provided with it.
Mobile Printing

Your printer can be connected to the Internet and the Web, providing various benefits.

- Automatic firmware updates (see Firmware update on page 65)
- Print on HP printers from almost anywhere with HP Smart App
- Print on HP printers from almost any device, including smartphones and tablet computers

To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see http://www.hp.com/go/designjetmobility.

Enable email printing

Turn on Web Services to allow your printer to communicate securely over the Internet with web-connected printing services.

1. Make sure that your printer is correctly connected to the Internet.
2. Enable Web Services during initial setup of the printer, or later by touching on the home screen and following the instructions on the front panel. The printer may need to restart if it has updated its firmware.
3. Retrieve the printer’s email address by touching on the home screen at any time.
4. This is an optional step: If you are the printer administrator, log in at HP Smart (http://www.hpsmart.com) to customize your printer’s email address or manage user access for remote printing.

For the latest information, support, and terms of use of the HP Smart see http://www.hpsmart.com. You can also benefit from automatic firmware updates after following this setup.

Reports

The internal prints give various kinds of information about your printer. They can be requested from the front panel.

Before requesting any internal print, check that the printer and the paper are ready for printing. The loaded paper should be at least A4 portrait—210 mm (8.27 in) wide—otherwise the print may be clipped.

To print any internal print, tap , then scroll down to Reports and tap it, then select the internal print you want. These are some of the prints available:

- Demo prints that show some of the capabilities of the printer
  - Drawing demo
  - Rendering demo
  - GIS map demo
- User info prints
  - Printer status report
  - Print quality report
  - Web access test report
  - Network configuration
- Wireless test report
- Job log
- Error log
2 Connecting the printer

Printing has never been easier, and your printer comes with various options for connecting to help you do so.

Choose which connection method to use

Your printer can be connected via Wireless, Gigabit Ethernet, or Hi-Speed USB.

Table 2-1 Connectivity methods

<table>
<thead>
<tr>
<th>Step 1: Connect the printer to your network:</th>
<th>OPTION B</th>
<th>Connect to Wi-Fi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the front panel to choose one of these options:</td>
<td>Connect to Wi-Fi - If the printer is new, just follow the steps in the front panel - Printer and device must be connected to the same Wi-Fi</td>
<td></td>
</tr>
<tr>
<td>OPTION A</td>
<td>Connect to Ethernet - If printer is new, connect the Ethernet cable before turning it on</td>
<td></td>
</tr>
<tr>
<td>Using your mobile</td>
<td>Connect to USB - Use Hi-Speed USB cable, male USB type A to male USB type B</td>
<td></td>
</tr>
</tbody>
</table>

Step 2: Set up your device:

- Printer and devices must be connected to the same network
- If required you can find your printer’s IP by scrolling down from the top of the screen

Automatic setup

Go to http://123.hp.com to download the HP software and driver

or

For advanced setup or additional software:


NOTE: If you connect an Ethernet cable, it turns off the wireless capability of the printer.
NOTE: Wireless connections can be affected by the location of the network router and the device. In order to improve a wireless connection:

1. Position the wireless access point in a more central position within the work place.
2. Place the wireless access point away from dense materials. Metal, concrete, double thick walls are the hardest to penetrate, wood and plasterboard are easier. Consider this when you position the printer.
3. Change the wireless channel to one that is not being used. Preferably 1, 6, or 11, as these are non-overlapping channels.
4. Extend the range of the wireless network with the use of a simple wireless extender or add more wireless access points.

1. Connect the printer to your network

If this is the first time you are using the printer: Connect your printer by using the HP Smart App.

NOTE: Use the HP Smart APP for printer Setup during initialization. If your printer is not new and you want to use the HP Smart App you need to go to the Default Configuration mode.

Set up using the HP Smart App

You can use the HP Smart App to set up the printer on your wireless network.

The HP Smart App is supported on iOS, Android, and Windows devices. For information, see Print from Apple iOS or Android with HP Smart App on page 33.

1. If you are using an iOS or Android mobile device, make sure that Bluetooth is turned on. (HP Smart uses Bluetooth to make the setup process faster and easier on iOS and Android mobile devices.)

NOTE: The HP Smart App uses Bluetooth for printer setup only. Printing using Bluetooth is not supported.

2. Open the HP Smart App.

3. Windows: On the home screen, tap Set Up a New Printer and follow the onscreen instructions to add a printer to your network.

   or

   Android: On the home screen, tap the + icon and then tap Add Printer. Follow the onscreen instructions to add a printer to your network.

Set up the printer on your wireless network

On the front panel, use the Wireless Setup Wizard or Wi-Fi Protected Setup to set up wireless communication.

1. From the front panel, tap or swipe down the tab at the top of the screen to open the dashboard, and then tap.

2. Tap.

3. Tap Wireless Settings.

4. Tap Wireless Setup Wizard or Wi-Fi Protected Setup.

5. Follow the front panel instructions to complete the setup.

If you are already using the printer with a different type of connection, such as a USB connection, to change see Mobile Printing on page 33.
2. Set up your device

Prepare your printer with the correct software for your device.

Install the software (Windows)

Make sure to connect the printer and computer or mobile device to the same network.


Install the software (Mac OS X)

Make sure to connect the printer and computer or mobile device to the same network.


Add your printer

Add a printer to a network under Mac OS X.

▲ Go to System Preferences ► Printers and Scanners, and then tap + to add a new printer.

● If you installed the driver: Select the IP tab, enter your IP address, and select the protocol HP Jetdirect-Socket. Tap Continue.

● If you want to use AirPrint: Choose your printer from the list of displayed network printers, and tap Add. Then, in the Use menu, select Secure AirPrint or AirPrint, and then tap Add.

★ TIP: To see the bonjour name on the front panel, open the printer’s dashboard and tap the or icon.

Other options

There are other ways to connect your printer directly to a computer.

Connect a computer to the printer by USB cable (Windows)

You can connect your printer directly to a computer without going through a network, by using the printer's built-in Hi-Speed USB device port. A USB connection may be faster than a network connection, but it has some disadvantages that you should bear in mind.

● The cable is of limited length.

● It is more difficult to share the printer.

● You cannot use Web Services.

● You cannot use automatic firmware updates.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor’s Forum (http://www.usb.org/) should be used with this printer.

Printer sharing considerations

Any other users sharing your USB-connected printer will be able to send print jobs, but will not be able to receive information from the printer—which affects status reports, administration and troubleshooting.
TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See Connecting the printer on page 13.
3 Setting up the printer

Set automatic firmware updates, email notifications and driver preferences, and control access to the Embedded Web Server.

Introduction

There are various printer settings that the printer administrator may wish to control as soon as a new printer is assembled and ready for use.

Automatic firmware update

The printer can automatically check for a firmware update periodically. See Firmware update on page 65

Turn email notifications on and off

In order to receive email notifications from the printer, you must have configured the email server.

- **SMTP server**: The IP address or hostname of the outgoing mail server (SMTP) that will process all email messages from the printer. If the mail server requires authentication, email notifications will not work.

- **Printer email address**: Each email message sent by the printer must include a return address, which does not need to be a real, functional email address, but it should be unique, so that recipients of the message can identify the printer that sent it.

You can turn specific email notifications on or off by clicking Email alerts in the Embedded Web Server tab.

Turn alerts on and off

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of your printing jobs changes its status. The alerts are displayed by the printer's front panel, by the HP Utility, by the printer driver and by the Embedded Web Server.

You can change the alert settings in various ways to display all, some, or none of the available alerts.

To access alert settings under Windows:

- Click Alert Settings in the Tools menu of the Embedded Web Server.
- Right-click the HP DesignJet Utility's system icon, and click Alert Settings.

In the Alert Settings window, you can use the Alerting slider to turn off alerts completely.
Alternatively, you can choose when, if ever, to display critical or non-critical alerts.

**To access alert settings under Mac OS X:**

- Open HP Printer Monitor preferences, select your printer, and then **Customize Alerts**, so that you can set each individual alert to appear in specific cases and with a specific time interval.

- You can turn off alerts completely by unchecking the **Show monitor status in menu bar** box in the Notifications tab of the HP Printer Monitor preferences. If you leave that box checked but uncheck the **Notify me when alert appears** box (as below), the alerts will be available in the HP Printer Monitor, but will not pop up in the Dock screen.
Control access to the Embedded Web Server

You can prevent users from modifying important device settings by setting a password in the Embedded Web Server.

Users without the password can see only the Information tabs. Once set, the password is required to view or change any parameters in the other tabs.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to set color or paper-saving options.

To change default settings, click the Start or Search button on your computer’s screen (depending on your version of Windows), then click Devices and Settings, Devices and printers or Print Management. Then right-click your printer’s icon and click Printing preferences or Set Printing Defaults. Any settings you change in the Printing Preferences window will be saved as default values for the current user.

To set the default values for all the users of your system, right-click the printer’s icon again, click Printer Properties, go to the Advanced tab, and click Printing Defaults. Any settings you change in the Printing Defaults window will be saved for all users.
4 Personalizing the printer

You can set your printer preferences such as language, sleep mode, firewall, and front panel brightness settings etc.

Change the language of the front-panel display

Your printer includes many language options to choose from.

To change the language of the front-panel menus and messages:

If you can understand the current front-panel display language, tap \( \text{Preferences} > \text{language} \). Select your preferred language.

Access the Embedded Web Server

Manage your printer remotely using an ordinary web browser running on any computer.

To access the Embedded Web Server on any computer, open your Web browser and type the IP address of your printer.

You can see your printer’s IP address on the front panel, open the dashboard and tap \( \text{Setup} \) or \( \text{Access} \).

To access the Embedded Web Server, you must have a TCP/IP connection to your printer. You can access the Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a TCP/IP connection (wired or wireless).

The first time you access the Embedded Web Server, the computer requests your username and password to prevent unauthorized users from remotely configuring the printer, or viewing printer settings. The password is required to change or view printer settings. By default the user is \text{admin}. The PIN is found behind the printer.

You can print the printer status report: \text{Setup} \rightarrow \text{Reports} \rightarrow \text{Printer status report}.

\text{NOTE:} The status report has the PIN. If you changed the initial PIN by default and forgot it, go to \text{Troubleshooting general printer issues on page} 95.

The following browsers are known to be compatible with the Embedded Web Server:

- Microsoft Internet Explorer 11 and later for Windows 7 and later
- Apple Safari 8 and later for OS X 10.10 and later
- Mozilla Firefox (latest version)
- Google Chrome (latest version)

If you have followed these instructions but failed to get through to the Embedded Web Server, see \text{Cannot access the Embedded Web Server on page} 96.

Change the language of the Embedded Web Server

The default language is the same as your browser but if it is not supported, it will appear in English. You can change it to any supported one.
Embedded Web Server supported languages are English, Portuguese, Spanish, French, Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. There is a tab at the top right of the window to select them from.

**Access the HP Utility (Windows only)**

Manage your printer from a computer with a USB, TCP/IP, or Wi-Fi connection.

The first time you access to the application you need to enter the printer information. Enter the printer’s IP address or hostname to add it to the printer list. Alternatively, select General search to find all HP DesignJet and HP PageWide XL printers on your network.

- **Under Windows**, start the HP Utility from your desktop shortcut or from Start > All Programs > HP > HP DesignJet Utility > HP DesignJet Utility. This launches the HP DesignJet Utility, showing the HP DesignJet printers installed on your computer.
- When you select your printer in the left pane, everything that appears in the right pane is specific to that printer.

**Change the language of the HP Utility**

Choose from English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

- **Under Windows**, the language will be adjusted to your regional language settings as defined in the Windows Control Panel.

**Change the sleep mode setting**

If the printer is left switched on but unused for a certain period of time, it automatically goes to sleep to save power.

To change the time the printer waits before it goes into sleep mode, go to the front panel and tap , then Power management > Sleep mode. Select the wait time you want.

**Configure power button mode**

You can set the printer to turn itself off or enter into sleep mode.

Go to , then Power Management►Power Button Mode and select the option you want.

To change the time that elapses before sleep mode, tap , then Power Management►Sleep Mode. You can set a time between 5 minutes and the maximum time allowed by the current energy savings regulations.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

**Change the auto-off setting**

The printer can be set to turn itself off automatically which is useful for power management control.
For example, setting the printer’s auto-off feature to 2 hours would turn the printer off after 2 hours of inactivity. In this way, you can save more energy. However, the auto-off feature is automatically disabled when the printer is connected to a network, to avoid inconveniencing network users.

If you are using a USB connection, you can set the printer to turn itself off completely after 2 to 12 hours of inactivity. At the front panel, tap [ ] then Power Management > Auto-off.

Change the front-panel display brightness
The level of brightness displayed can be adjusted.
To change the brightness of the front-panel display, tap [ ] then Preferences > Screen brightness and select the value you want. Tap Done to set the value.

Configure network settings
You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front panel.

- From the Embedded Web Server: Select the Network tab.
- From the HP Utility: You can access the Embedded Web Server through the HP Utility.
- From the front panel: Swipe down the dashboard, tap [ ] then scroll down the menu and touch Network setup.

The following options are available:
- **Print the start Guide** to print the instructions
- **Enable/Disable wireless** turns the wireless connection on or off.
- **Wireless setup wizard** provides an easy way to connect to a wireless network.
- **Wi-Fi protected setup** allows you to set up a connection with a wireless network using WPS (pushbutton or pin) encryption.
- **View wireless details** displays information about the wireless network
- **IP settings** allows you to select the IP address - automatic or manual (Static)
- **Print Wireless test report** print information about the wireless network
- **Print wireless network test** runs diagnostic tests of wireless connectivity
- **Ethernet settings** view and print ethernet details
- **Advanced setup**
  - **Link speed** sets the speed at which data are transmitted over the network. The default is Automatic.
  - **IP settings** allows you to view or change the IP address, subnet mask, default gateway, and DNS address.
  - **General settings**
    - **Hostname** allows you to change the hostname.
    - **Proxy settings** allows you to change the proxy settings
    - **Bonjour name** allows you to change the bonjour name
• Restore network defaults

Configure firewall settings

Firewall features provide network-layer security on both IPv4 and IPv6 networks. The firewall provides simple control of IP addresses that are allowed access.

**NOTE:** In addition to firewall protection at the network layer, the printer also supports open secure sockets layer (SSL) standards at the transport layer for secure client-server applications, such as client-server authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply to specified IP traffic. Firewall policy pages are accessed through the Embedded Web Server and displayed by your Web browser. After a policy is configured, it is not activated until you click **Apply** in the Embedded Web Server.

Creating and using firewall rules

Control IP traffic and allow or drop IP traffic based on IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the action to take for those addresses and services.

Create a firewall rule

Set up a new rule from the Embedded Web Server.

1. Open the Embedded Web Server.
2. Tap the **Settings** tab, then **Firewall ► Firewall Rules**.
3. Select **Enable Firewall**.
4. Tap **Apply**, and then follow the onscreen instructions.

**NOTE:** After you tap **Apply**, the connection to the Embedded Web Server might be temporarily disrupted for a short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Change the priority of firewall rules

You can move a rule up or down in the priority list.

1. Open the Embedded Web Server.
2. Tap the **Settings** tab, then **Firewall ► Firewall Rules Priority**.
3. Select the priority from the Rule Precedence list, with 10 having the highest priority and 1 having the lowest priority.
4. Tap **Apply**.

Change firewall options

Options can always be edited at a later date.

1. Open the Embedded Web Server.
2. Tap the **Settings** tab, then **Firewall ► Firewall Options**.
3. Change whatever options you wish, then tap **Apply**.
NOTE: After you tap Apply, the connection to the Embedded Web Server might be temporarily disrupted for a short period of time. If the IP address was unchanged, the Embedded Web Server connection will be enabled again. However, if the IP address was changed, use the new IP address to open the Embedded Web Server.

Reset firewall settings

Restore the printer’s network settings to reset to factory defaults.

Limitations to rules, templates, and services

There is a limit per item that can be created and stored at any one time.

<table>
<thead>
<tr>
<th>Table 4-1 Limitations per item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
</tr>
<tr>
<td>Maximum number of rules</td>
</tr>
<tr>
<td>Maximum number of address templates</td>
</tr>
<tr>
<td>Maximum number of user-defined address templates</td>
</tr>
<tr>
<td>Maximum number of services you can add to a user-defined service template</td>
</tr>
<tr>
<td>NOTE: The predefined All Services template is not subject to this limitation and includes all services supported by the print server.</td>
</tr>
<tr>
<td>Maximum number of services you can add to the policy</td>
</tr>
<tr>
<td>NOTE: For a given rule, only one address template and one service template can be added.</td>
</tr>
<tr>
<td>Maximum number of service templates in the policy</td>
</tr>
<tr>
<td>Maximum number of user-defined custom service templates</td>
</tr>
</tbody>
</table>

Reset network settings

The administrator password and network settings can be restored.

Go to the front panel, swipe down the dashboard and tap Network setup, then scroll down the menu and tap Network setup > Restore network settings

NOTE: Print the network configuration page and check that the network settings have been reset.

NOTE: Resetting the printer’s network settings also resets the printer’s firewall settings.

Embedded Web Server security settings

Set a password and create an administrator account to control access and changes.

From the Embedded Web Server menu, tap Settings ➤ Security.

Password settings:

You can set a password to prevent unauthorized users from remotely configuring the printer or viewing printer settings from the embedded web server (EWS). Once set, this password is required to change or view many printer settings from the EWS.

To disable the password, leave the boxes blank.
Administrator password:

You can control access to the printer by specifying an administrator account to control access to the Embedded Web Server. You can customize your printer by enabling or disabling the features available. After a feature has been disabled, it is not available from the EWS or printer's front panel.
To print you can load rolls, single sheets, or use the multi-sheet tray. View paper information and use the printer's cutting tool.

**General paper-loading advice**

You can load paper into the printer in three different ways: from a roll, as a single sheet, or as a stack of single sheets from the multi-sheet tray (if you have one). Switching from one to another is automatic.

⚠️ **CAUTION:** If your model has a stand, make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

⚠️ **CAUTION:** All paper must be 280 mm (11 in) or wider. A4 and letter paper should not be loaded in landscape orientation.

💡 **TIP:** For photo paper wear cotton gloves to avoid transferring oils onto the paper.

⚠️ **CAUTION:** Keep the bin closed throughout the loading process.

**Load a roll onto the spindle**

Rolls of different widths can be loaded onto the printer.

1. Remove the spindle from the printer.

⚠️ **WARNING!** Do not insert your fingers into the spindle supports during the removal process.

2. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the end of the spindle.
3. If the roll is long, rest the spindle horizontally on a table and load the roll on the table.

4. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the correct orientation.

![NOTE: From the back of the printer, the blue stopper is inserted into the right-side holder.]

Ensure both ends of the roll are as close to the spindle stops as possible.

5. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

6. Ensure the blue paper stop is pushed in as far as it goes. Check that there is no space between the roll and the stops at both ends.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of different paper types on different spindles. Extra spindles are available for purchase, see Accessories on page 67.

**Load a roll into the printer**

Before you start this procedure, you must have a roll loaded on the spindle.

See Load a roll onto the spindle on page 26.

1. From the front panel, tap [ ] then [ ].

   This step is optional: if you just start feeding in roll paper, the printer recognizes that you want to load a roll.

2. Insert the spindle into the printer, holding it by both ends. The blue hub should be on the left, as viewed from the front of the printer.
3. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the paper slightly and cut a straight edge.

4. Insert the edge of the paper into the printer.

**WARNING!** Do not push your fingers inside the printer’s paper path.

5. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer detects the paper, it beeps, and feeds in the paper automatically.

6. The front panel prompts you to select the paper category and type.

   If you do not see your paper type in the front panel, tap More paper types. If you still cannot find your paper type in the whole list, see Paper type is not in the driver on page 71.

7. The printer checks the alignment and measures the width. If the roll is not correctly aligned, follow the instructions on the front-panel display.

**NOTE:** If you have an unexpected issue at any stage of the paper loading process, see Paper cannot be loaded successfully on page 69.

---

**Unload a roll**

If there is paper on the roll, you can unload it from the front panel.

Tap  then  then Unload roll. Afterwards, the multi-sheet tray will become the default active paper source.

If the end of the paper is no longer attached to the core, the front panel asks you to unload the roll manually.

After unloading, the multi-sheet tray is the default active paper source.

---

**Load a single sheet**

Roll paper and single sheets use the same input slot in the printer.

**NOTE:** If you have a multi-sheet tray see Use the multi-sheet tray on page 29.

**NOTE:** Sheets of width 329 mm (12.95 in) or less should be loaded from the multi-sheet tray.

1. At the front panel, tap  and then .

2. If a roll is already loaded, you have to wait while it is automatically unloaded.

3. Open the roll cover.

4. Select your paper category and type. If you do not see your paper type in the front panel, tap More paper types. If you still cannot find your paper type in the whole list, see Paper type is not in the driver on page 71.
5. When prompted by the front panel, insert the sheet into the right-hand side of the input slot.

![Image](image1.png)

**WARNING!** Do not push your fingers inside the printer's paper path.

6. Align the sheet with the blue line.

![Image](image2.png)

7. Tap **OK** on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is especially important with thicker papers.

8. The printer checks the alignment and measures the sheet.

![Image](image3.png)

**NOTE:** Depending on the width of the sheet, it feeds out the front of the printer.

9. If the sheet is not correctly aligned, you may be asked to reload it.

![Image](image4.png)

**NOTE:** If you have an unexpected problem at any stage of the paper loading process, see Paper cannot be loaded successfully on page 69.

## Unload a single sheet

Sheets are unloaded from the front of the printer.

To unload a sheet, go to the front panel and tap **Unload**. Then tap **Unload**. Either catch the sheet manually or allow it to fall into the bin.

After unloading, the multi-sheet tray is the default active paper source.

## Use the multi-sheet tray

You can load multiple sheets and ease single sheet printing.

1. If no roll is loaded or the roll has run out of paper, the multi-sheet tray is active by default.

Alternatively, at the front panel, tap **Multi-sheet** then **Unload**.
2. Adjust the input tray extensions depending on the length of the paper: the first extension for A4 and the second extension for A3 paper.

3. Load sheets of paper into the tray with the printed side facing outwards. Ensure that the sheets are all of the same size.

4. Adjust the tray to fit the width of the paper.

View information about the paper

Tap the icon of the active paper source.

The following information is displayed on the front panel:
- Paper type you have selected
- Roll or sheet status
- Width of the paper

If no roll and no single-sheet paper is loaded, the message **Out of paper** is displayed.

**Maintain paper**

Always protect your paper and sheets to print at the highest quality.

- Store rolls covered by another piece of paper or cloth
- Store cut sheets covered and clean or brush them before loading them in the printer
- Clean input and output platens
- Always keep the top cover of your printer closed

**NOTE:** Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 83.

**Change the drying time**

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where time is of higher importance or when you need to be sure ink is dry before handling.

Tap ☑, then **Printer preferences** > **Print retrieval** > **Select drying time**. You can select:

- **Extended**, to set a longer than recommended time to ensure ink is completely dry
- **Optimized**, to set the default and recommended time for your selected paper (this is the default setting)
- **None**, to disable the drying time and remove your print as soon as it finishes printing

**CAUTION:** If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the print.

**NOTE:** If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the paper until after the printhead maintenance has completed.

**Turn the automatic cutter on and off**

You can change the cutter option to suit your requirements for each print job.

To turn the printer’s paper cutter on or off, go to the front panel and tap ☑, then **Print Settings** and change the cutter option.

The default setting is **On**.

**NOTE:** If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on loading and unloading rolls.

**TIP:** To cut roll paper while the automatic cutter is disabled, see Form feed and form feed and cut on page 32.
Form feed and form feed and cut

You can advance the paper with, or without cutting it.

Go to the front panel and tap 📝, then Form feed. There are 2 options: Form Feed and Form feed and Cut. The Form feed option advances the paper without cutting it. Form feed and cut advances the paper and makes a straight cut across the front edge. There are at least two possible reasons why you might want to do this:

- To trim the leading edge of the paper if it is damaged or not straight.
- To feed and cut the paper when the automatic cutter has been disabled.

**NOTE:** The printhead is serviced after each print, and the paper cannot be cut until the process completes, so you may notice a delay.

**CAUTION:** Remove the cut piece from the output platen. If strips or short prints are left on the output platen, the printer could jam. Check also that there are no pieces of paper in the cutter guide.

**NOTE:** Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 83.
6 Printing

Printing has never been easier or more flexible. Print from computers and mobile devices with the use of a variety software, customizable options and advanced settings.

Mobile Printing

You can print to your printer from many mobile devices using direct printing by connection to the same network.

Print from mobile devices

With HP Mobile Printing Solutions you can print straight from your smartphone or tablet in just a few simple steps.

- Apple iOS printing is enabled through AirPrint, which comes pre-installed in iOS devices.
- For Android printing, install the HP Print Service Plugin from Google Play (if you do not have it already pre-installed in your mobile device).

For more information, see http://www.hp.com/go/designjetmobility.

Print from Android

Install and enable the HP Print Service App from Google Play.

You can download the App from: https://play.google.com/store/apps/details?id=com.hp.android.printservice, if it is not already installed in your device. You must have Android Lollipop 5.0 or later.

1. Open the document or photo you want to print, and tap the menu icon, then Print.
2. Choose your printer from the list.
3. Check the print settings, then tap Print.

iOS (iPhone, iPad) with AirPrint

Printing with AirPrint is simple, all you have to do is make sure your device and printer are operating on the same network.

Follow the steps below:

1. Choose your content. Open the document or photo you want to print, then tap the share button.
2. Select print icon.
3. Confirm that the correct printer and print setting are selected. Tap Print and collect your printed documents.

Print from Apple iOS or Android with HP Smart App

Connect and print wirelessly from an Android or Apple smartphone or tablet.

1. Open HP Smart App and browse for the document or photo you want to print.

2. Go to Edit to adjust the output if necessary.

3. Tap Print.

With HP Smart App you can also print even when your mobile device and your printer are not in the same network.

Remote Printing feature can be enabled either during the initialization process if you choose to do it with HP Smart. Otherwise, it can be enabled later.

**NOTE:** Inside HP Smart, enable your printer for remote printing by pressing the **printer icon**. Check the option **Print Anywhere** in printer options and follow the steps in the app.

**NOTE:** Remote Printing feature requires that device and printer are connected to Internet.

**NOTE:** Remote Printing feature requires to have an HPSmart.com account. If you don’t have an account, HP Smart will guide you to create one.

If Remote Printing feature is configured in your printer, the owner of the printer can manage the remote printing access to share the printer with other users:

1. Open HP Smart App, select your printer and press the **printer icon**.

2. If you are the owner of the printer, you will see an option called **Manage Print Anywhere**. Tap it.

3. Decide whether to share the printer with others or grant/revoke access individually.

**NOTE:** The owner of the printer is the HPSmart.com user that has registered the printer in their account.

### Print using Wi-Fi Direct

With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable device—without connecting to an existing wireless network.

### Guidelines for using Wi-Fi Direct

There are essential prerequisites to using Wi-Fi Direct.

- Make sure your computer or mobile device has the necessary software.
● If you are using a computer, make sure you have installed the HP printer software.
● If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first and then install the printer software. Select Wireless when prompted by the printer software for a connection type.
● If you are using a mobile device, make sure you have installed a compatible printing app. For more information, visit the HP Mobile Printing website at http://www.hp.com/go/mobileprinting. If a local version of this website is not available in your country/region or language, you might be directed to the HP Mobile Printing website in another country/region or language.
● Make sure Wi-Fi Direct for your printer is turned on.
● Up to five computers and mobile devices can use the same Wi-Fi Direct connection.
● Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to a network using a wireless connection.
● Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet.

Turn on Wi-Fi Direct

You can turn on Wi-Fi Direct directly from the front panel, or alternatively from the EWS.

1. From the printer front panel, tap or swipe down the tab at the top of the screen to open the dashboard, and then tap
2. Tap
3. If the display shows that Wi-Fi Direct is Off, tap Wi-Fi Direct and then switch it on.
4. You can also turn on Wi-Fi Direct from the EWS. For more information about using the EWS, see Access the Embedded Web Server on page 20.

Change connection method

You can change the Wi-Fi Direct connection method, and choose between automatic and manual.

1. From the printer front panel, tap or swipe down the tab at the top of the screen to open the dashboard, and then tap
2. Tap
3. Tap Connection Method and then select Automatic or Manual:
   ● If Automatic was selected during Wi-Fi Direct setup on the printer, the mobile device automatically connects to the printer.
   ● If Manual was selected during the Wi-Fi Direct setup on the printer, acknowledge the connection on the printer display or enter the printer PIN on your mobile device. The PIN is provided by the printer when a connection attempt is made.

Print from a wireless-capable mobile device that supports Wi-Fi Direct

Make sure you have installed the latest version of HP Print Service Plugin on your mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.
1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on Wi-Fi Direct on your mobile device. For more information, see the documentation provided with the mobile device.

3. From your mobile device, select a document from a print enabled application, and then select the option to print the document.

   The list of available printers appears.

4. From the list of available printers, choose the Wi-Fi Direct name shown such as DIRECT-**-HP DesignJet T200 Printer or DIRECT-**-HP DesignJet T600 Printer (where ** are the unique characters to identify your printer), and then follow the onscreen instructions on the printer and your mobile device.

5. Print your document.

**Print from a wireless-capable mobile device that does not support Wi-Fi Direct**

Make sure you have installed a compatible printing app on your mobile device.


1. Make sure you have turned on Wi-Fi Direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation provided with the mobile device.

**NOTE:** If your mobile device does not support Wi-Fi, you are not able to use Wi-Fi Direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a new wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown such as DIRECT-**-HP DesignJet T200 Printer or DIRECT-**-HP DesignJet T600 Printer (where ** are the unique characters to identify your printer).

4. Enter the Wi-Fi Direct password when prompted.

5. Print your document.

**Print from a wireless-capable computer (Windows)**

To use Wi-Fi Direct, your computer must support Wi-Fi.

This example is for Windows 10.

1. Go to Start ► Settings ► Devices ► Printers & scanners, and tap Add a printer or scanner to add the Printer.

   **NOTE:** If your printer is not listed, you may need to wait until the Show Wi-Fi Direct printers link appears.

2. Identify your Wi-Fi Direct, its name starts with the suffix DIRECT-XX-HP...

3. Depending on the Wi-Fi Direct connection method configured for your printer, you may need to accept the connection by tapping the message in the front panel.

4. When connection is established, Windows downloads the appropriate driver and adds the printer to your system.

5. Once added, the printer is ready for use with any Windows application.

**Easy printing with HP Click**

HP Click is an easy-to-use tool designed for people who want a simple way of printing on large format printers.
Ideal for a broad range of graphics and technical applications, including posters, roll-up banners, info-graphic presentations, maps, and CAD documents. See http://www.hp.com/go/designJet.

**Printing from an application using a printer driver**

This is the traditional way of printing from an application.

The correct printer driver must be installed on the computer (see Connecting the printer on page 13), and the computer must be connected to the printer by network or USB cable.

When the printer driver has been installed and the computer is connected to the printer, you can print from a software application by using the application’s own Print command and selecting the correct printer.

**Advanced print settings**

Advanced print settings can be used when the defaults do not meet your requirements.

The rest of this chapter explains the various print settings that you can use. These methods offer a relatively large number of settings in order to satisfy all requirements.

**TIP:** In general you are recommended to use the default settings unless you know that they do not meet your requirements.

**TIP:** If you intend to reuse a particular group of settings repeatedly, you can save those settings under a name of your own choice and recall them later. A saved group of settings is known as a ‘quick set’ in the Windows printer driver.

**Select print quality**

The printer has various print-quality options because best-quality printing requires some loss of speed, while fast printing implies some reduction in print quality.

You can select the options: **Best**, **Normal** and **Fast**. If you select **Fast**, you can also select **Economode**, which consumes less ink, increases printing speed even further, but reduces print quality. **Economode** can only be selected from the advanced options.

There are supplementary custom options that may have an effect on print quality: **Maximum detail**. See High-quality printing on page 41.

- **In the Windows driver dialog:** Go to **Print quality**, then depending on the selection, more specific options such as **Economode** or **Maximum detail** which can only be selected from the advanced options.

- **In the Mac OS X Print dialog:** go to the **Paper/Quality** panel and look at the **Quality Options** section. If you select **Standard** quality options, you will see a simple slider with which you can select speed or quality. If you select **Custom** quality options, you will see the more specific options described above.

**NOTE:** If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

**NOTE:** You cannot change the print quality of pages that the printer is already receiving or has already received (even if they have not started to print yet).

**Select paper size**

The paper size can be specified and the document can be rescaled if necessary.

**NOTE:** The paper size specified should be the paper size the document was created at. It is possible to rescale the document to a different size for printing. See Rescale a print on page 39.
• **In the Windows driver dialog:** Select the paper size from the **Document Size** list.

• **In the Mac OS X Print dialog:** Select your printer from the **Printer** list, then select your paper size from the **Paper Size** list.

> **NOTE:** If your application offers no **Page Setup** dialog, use the **Print** dialog.

> **NOTE:** If the paper size is set from your computer, it overrides the paper size setting in the front panel.

**Custom paper sizes**

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various different ways to specify it.

**Use the Windows printer driver**

You can create and save custom paper sizes to suit your requirements.

1. Go to **Basic > Document size**.
2. Open the drop-down list, scroll down to the **Custom** section and tap on **Create**.
3. Enter the name, unit, and size of the new paper custom size.
4. Tap the **Save** button.

Custom paper sizes created with the printer driver have the following characteristics:

- The paper size is permanent and does not disappear if the driver is closed or the computer is turned off.
- The paper size is local to the printer queue and not seen from other printer queues in the same computer.
- In Domain server networks, the paper size is local to the computer and not seen from other computers sharing the printer queue.
- In Workgroup networks, the paper size is shared among all the computers that share the printer queue.
- If the printer queue is deleted, the paper size is deleted with it.

**Use Windows forms**

Unrestricted users can create a new Windows form.

1. From the **Start** menu or the front panel, tap **Printers > File**, and select **Server Properties**.
   
   Windows 7: From the **Start** menu or the front panel, tap **Devices and Printers**, then **Select Printer**.

2. In the **Forms** tab, check the **Create a new form** box.
3. Enter the name and dimensions of the new paper size. Leave the margins as 0.00.
4. Tap the **Save form** button.
5. Go to the printer driver and select the document size.
6. Select your new paper size from the group of **Custom sizes**.

Paper sizes created with Windows forms have the following characteristics:

- The paper size is permanent and does not disappear if the driver is closed or the computer is turned off.
- Restricted users cannot create paper forms. The **manage documents** role in the Windows Active Directory is the minimum required.
The paper size is local to the computer and is seen in all the printer queues created on the computer that support paper that size.

- If a printer queue is shared, this paper size appears in all the client's computers.
- If a printer queue is shared from another computer, this paper size doesn't appear on the driver's document size list. A Windows form in a shared queue must be created in the server.
- If the printer queue is deleted, the paper size does not disappear.

**Use Mac OS X printer driver**

You can manage paper customs sizes from the driver.

1. Go to the **Print** dialog.
2. Select **Paper Size** ➤ **Manage Custom Sizes**.

**Select margins options**

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper. However, you can change this behavior in the following way:

- **In the Windows driver dialog**: Select the correct option in the **Margin layout** area.
- **In the Mac OS X Print dialog**: Select the **Margins/Layout** panel.

At least some of the following options appear:

- **Standard** or **Use application settings**. Your image will be printed on a page of the size you have selected, with the default margin between the edges of the image and the edges of the paper. The image should be small enough to fit between the margins.
- **Oversize**. You should load paper that is larger than the size you selected in the application or driver. If you cut off the margins after printing, you will be left with a page of the size you selected, with no margins remaining between your image and the edges of the paper. This is useful when you want your image to cover the whole area of the paper.
- **Clip Contents By Margins**. Your image will be printed on a page of the size you have selected, with the default margin between the edges of the image and the edges of the paper. In this case, if the image is the same size as the page, the printer assumes that the extreme edges of the image are either white or unimportant, and do not need to be printed. This may be useful when your image already contains a border.

**Print on loaded paper**

You can print a job on whichever substrate is loaded in the printer.

- **In the Windows driver dialog**: Select **Use printer settings** in the **Paper Type** option of your printer driver.
- **In the Mac OS X Print dialog**: Select the **Paper/Quality** panel, then in the **Paper Type** drop-down list, select **Any**.

**NOTE:** Use printer settings is the default **Paper Type** selection.

**Rescale a print**

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally larger). This may be useful:
- If your software does not support large formats
- If your file is too large for the printer’s memory; in which case you can reduce the paper size in your software and then scale it up again using the front panel option

**You can rescale an image from the Windows driver dialog:** Go to the **Advance options > Scale**.

- By selecting a paper size, the image size is adjusted to the paper size you have selected. For example, if you have selected ISO A2 and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 size is selected, the printer reduces a larger image to fit the A4 size.
- The **percentage of actual size** option enlarges the printable area of the original paper size by the percentage indicated, and then adds the margins to create the output paper size.

**In the Mac OS X Print dialog:** Select the **Paper Handling** panel, then **Scale to fit paper size**, and select the paper size to which you want to scale the image. If you want to increase the size of the image, make sure that the **Scale down only** box is unchecked.

If you are printing to a single sheet, you must ensure that the image fits onto the sheet, if not the image will be clipped.

**Preview a print**

If you preview a print on the screen you can check the layout before you print, which may help avoid paper and ink wastage.

- To preview a print under Windows, you have the following options:
  - Use the HP Print Preview application:
    - Check the **Show preview before printing** box, which you can find in the right bottom corner of the driver dialog. Click **Print**, then wait a few seconds for the HP Print Preview application to be launched.
    - Check that the job preview is as you wanted, and if it is, click **Print**. If it isn’t as you wanted, then modify the **Print Preview** options and check again, or click **Cancel**.

  **NOTE:** You can readjust the driver settings before you try again.

  **NOTE:** The **Show preview before printing** box appears in the driver dialog only if HP Print Preview is installed in your computer. If not installed, a download link is displayed.

  - Use your application’s print preview option.

- To preview a print under macOS, you have the following options:
  - Use your application’s print preview option.
  - There is no **Preview** button at the bottom of the Print dialog box in the latest versions of macOS. A print preview is always shown at the upper left of the Print dialog box for most applications.
  - Choose the **HP Print Preview** option from the **PDF** menu at the bottom of the Print dialog box. The print preview is displayed by a separate HP Print Preview application.

**Print a draft**

You can specify this to save time and cost.

- **In the Windows driver dialog:** Go to **Print quality** and select **Fast**.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for documents containing only text and line drawings:
• **In the Windows driver dialog**: Go to **Print quality**, set the quality level to **Fast** and check the **Economode** box.

• **In the Mac OS X Print dialog**: Go to the **Paper/Quality** panel and move the print-quality slider to the extreme left (**Speed**).

**High-quality printing**

For unrivaled image quality.

• **In the Windows driver dialog**: Go to **Print quality** and select **Best**.

• **In the Mac OS X Print dialog**: Go to the **Paper/Quality** panel and move the print-quality slider to the extreme right (**Quality**).

**If you have a high-resolution image**

You can improve print sharpness when using glossy paper.

If your image has a resolution greater than the rendering resolution (which you can see in the **Custom Print Quality Options**), print sharpness may be improved by selecting the **Maximum Detail** option.

This option is available only if you are printing on photo paper and you have selected **Best** print quality.

**NOTE:** The **Maximum Detail** option results in slower printing with photo papers, but it does not increase the amount of ink used.

**Use paper economically**

You may be able to save some of your roll paper by removing blank areas and/or by image rotation.

• **In the Windows driver dialog**: Check the **Remove blank areas** box.

  You can also select one of the **Rotation** options.

• **In the Mac OS X Print dialog**: Select **Finishing panel ► Remove Blank Areas**.

**Use ink economically**

There are some recommendations you can follow to save ink.

• Check the print preview on your computer before you print and avoid wasting paper on prints containing obvious mistakes. See **Preview a print on page 40**.

• For draft prints use plain paper, select **Print quality**, then **Fast**. For more economy, select **Economode**.

• Clean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small amount of ink.

• Leave the printer permanently turned on so that it can maintain the printhead in good condition automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the printer may need to use much more ink later to maintain the printhead.

• Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some ink, and its frequency is related to the number of passes made by the printhead.

**Color management**

Your printer has been engineered with advanced hardware and software features to ensure predictable and dependable color results.
State-of-the-art HP printheads and HP inks

Dedicated color resources for most available paper types

**Color management options**

Reproduce colors as accurately as possible on all devices. When you print an image, you see very similar colors to the image on your monitor.

Color management is highly dependent on the paper type loaded on the printer, so take care to select the correct preset for the paper type used. The color management options for your printer can be selected from the **Color** options section in the Windows driver dialog. In some applications you can make the choice in the application itself. Consult [HP Support Center on page 100](#) for information about how to use the color management options in your application.

- **Application-Managed Colors**: Your application must convert the image colors to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and paper type.

- **Printer-Managed Colors**: Your application sends the image to the printer without any color conversion, and the printer converts the colors to sRGB. This source profile emulates the characteristics of the average computer monitor. This standard space is endorsed by many hardware and software manufacturers and has become the default color space for many scanners, cameras, printers, and software applications.

Printer color management is completed using a set of stored color tables. ICC profiles are not used. This method can produce very good results with supported HP paper types.

**Printing in grayscale or black-and-white**

There are a number of ways to convert all the colors in your image to shades of gray.

- **In your application program**: Many applications provide this option.

- **In the Windows driver dialog**: In the **Color mode** selection, tap **Print in Grayscale**. Only black ink is used to print, except if the paper loaded is glossy, in which case colored inks are used to compose the gray shades. You can also select **Print in pure black and white** for black and white output only, with no gray shades. In this case only black ink is used to print. The **Print in pure black and white** option is not supported when you print on glossy paper.

- **In the Mac OS X Print dialog**: Go to the **Color Options** panel and from the **Mode** drop-down list, select **Grayscale**. Only black ink is used for printing, unless the paper loaded is glossy, in which case the other inks are used to compose gray shades. You can also select **Pure black and white** for black and white output only, with no gray shades. In this case, only black ink is used for printing. The **Print in pure black and white** option is not supported when printing on glossy paper.
7 Practical printing examples

Step by step examples to print drafts, projects, presentations etc. to help you follow correct procedure with your jobs.

Print a draft for revision with the correct scale

Page size and orientation may not always be set as you require. This can be altered.

Using Adobe Acrobat

Print a revision draft with the correct scale.

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check the page size.

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

   NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button.

4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom paper size, follow the instructions in Custom paper sizes on page 38.

5. Select Rotation, then Autorotate.

6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print a PDF multipage job from Adobe Acrobat Reader or Adobe Acrobat Pro

Set up for a multipage job is a quick and simple process.
Using a raster driver

You can print a multipage job from Adobe Acrobat.

1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the latest version).
2. Click File > Print.
3. Select the printer and driver.
4. Check the Choose paper source by PDF page size box.

5. Adjust other properties in the driver properties window, as required.
6. Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Print a document with the correct colors

Print a document from Adobe Acrobat and Adobe Photoshop, with the emphasis on color management.

Using Adobe Acrobat Reader

The print process is very simple. Acrobat Reader is the most basic application for PDF files; several color management tools common in more sophisticated applications are not explicitly present, and work by default with presets that cannot be changed.

For example, there is no way to select a working color space; a default color space, most likely sRGB, is applied. This color space is used for screen display, for example. Also, as an alternative color profile when no other is specified by a file, as will be explained later.

1. Click File > Print.
2. Select the printer and driver from the **Printer** drop-down menu in the **Print** dialog box. Driver settings can be adjusted by clicking the **Properties** button.

![Printer Properties dialog box](image)

3. Adjust the color settings in the driver properties window. Click the **Properties** button in the **Print** dialog and set the **Color** option in the **Color mode** section. Click **OK**.

4. Click the **Advanced** button in the **Print** dialog box to set color management options. Check the box **Let printer determine colors**.

![Advanced Print Options](image)

5. If the document contains several color profiles and you are not sure what the result will be, you can flatten the document first and print it as seen on the screen. To do this, check the box **Print As Image** in the Advanced Print Setup dialog box. In this case, the rasterization is performed by Acrobat Reader before calling the driver; whereas, if you do not check this box, the rasterization is performed by the driver. So checking the box may have a visible effect on the look of the printed document.
Using Adobe Acrobat Pro

This is a professional application that allows full color management. See briefly described, the options to select a working color space, convert images to a desired color space, and print.

1. PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working color space by default. To choose a working color space, first click **Edit > Preferences**.

2. In the Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

3. PDF files can contain elements with different color profiles. Some may have color profiles, some may not. The working color space will affect only those without a color profile. If you want to attach a specific color profile to the document, you must convert the contents of the document as follows. First, select **Convert Colors** from **View > Tools > Print Production** or by clicking the icon in the status bar.
4. Select the elements you want to convert by specifying matching criteria (object type and/or color type) and then the conversion attributes. If you want to change the embedded color profile, you can select Any Object and Any Colorspace in the Matching Criteria section. In the Conversion Attributes section you can choose, for example, to embed an Adobe RGB (1998) profile by selecting it as the Conversion Profile, checking the Embed box, clicking the OK button, and saving the file to keep the changes. The saved file will have an embedded Adobe RGB color profile.

5. To print the document, choose a printer from the Print dialog box, click the Properties button, and in the Color mode section, set the color options.

   **IMPORTANT:** Select Print in color and Printer managed colors.

6. In the Print dialog box, click the Print button to print the document.

**Using Adobe Photoshop**

The printer can manage colors directly.

1. In Photoshop, click File > Print, then select your printer.

2. In the Color Management section, set the Color Handling option to Printer Manages Colors.

3. In the driver’s Color section, ensure that the color management option is Printer managed colors. This is the correct option because you have already selected Printer Manages Colors in Photoshop.
Print a project using Autodesk AutoCAD

Set up a plot to print from a model or a layout.

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

2. Click the **Plot** icon at the top of the window.

3. The **Plot** window opens.
4. You can see further options by clicking the circular button in the lower right corner of the window.

![Plot dialog box](image)

**NOTE:** The Quality option here does not refer to the final print quality but to the quality of AutoCAD viewport objects that are sent for printing.

5. Select your printer and click the **Properties** button.

6. Select the **Device and Document Settings** tab, and click the **Custom Properties** button.

7. In the **Driver**, select the paper type that you intend to use.

8. Select the print quality.

9. If you intend to print on roll paper, you must decide where the printer should cut the paper.
   - With the Windows driver: Select **Margin Layout options > Clip content by margins**.

10. Select the **Rotation** option **Autorotate**. Autorotation can help to avoid wasting paper.

11. Click the **OK** button and save your configuration changes to a PC3 file.

12. When you have clicked the **OK** button in the Plot window, the printer will construct a print preview.
Print a presentation

Setup AutoCAD or Photoshop presentations.

Using Autodesk AutoCAD

Print a presentation with Autodesk AutoCAD.

1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then click the Properties button.
4. Select the Device and Document Settings tab, and click the Custom Properties button.

5. In the Driver, select the paper type that you intend to use.

   **NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll.

6. Select the print quality.

7. If you intend to print on roll paper, you must decide where the printer should cut the paper.
   - With the Windows driver: Select Margin Layout options > Clip content by margins.

8. Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.

9. Click the OK button and save your configuration changes to a PC3 file.

10. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

### Using Adobe Photoshop

Print a presentation with Adobe Photoshop.

1. In Photoshop, click **File > Print** and then select your printer.

2. Click **Print settings**, then select the **Document size** option.

3. Choose from the available paper sizes.
   - If you don't find your desired paper size, create it by following the instructions in Custom paper sizes on page 38.

4. Select **Show preview before printing**. You may also wish to change the default paper source, paper type and print quality.

5. In the **Color** section, the default color management option is **Printer managed colors**, which is the correct option as you have already selected Printer Manages Colors in Photoshop.
Print and scale from Microsoft Office

With the scale options you can scale documents to print at a particular size.

Using Microsoft PowerPoint

Scale a job to fit your page size and clip content by margins.

1. Click File > Print, and select the name of your printer.

2. Click the Scale option to scale the document to a particular size.

3. Select the Paper Source and Paper Type.

4. Depending on your driver version:
   ● With the Windows driver: Select the Margin Layout options, then Clip content by margins.

Using Microsoft Project

Use the proper scale option to scale a document to a particular size.

1. Click File > Print.

2. Select your printer’s name.
3. In the **Settings** section, you can choose the pages to print, the orientation, and the paper size.

4. Click **Page Setup** to choose the **Paper Size** you want.

5. Select **Options** to go to the printer driver.

   The default options are probably suitable: **Paper source**: Automatic and **Paper Type**: Use Printer Settings.

6. Click **Proper scale option** to scale the document to a particular size. Alternatively, you can scale the document in Project.
8  Handling ink cartridges and printhead

There are 4 replaceable ink cartridges that supply the printhead. You can check status information, and easily change an ink cartridge when required.

About the ink cartridges

Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper.

To purchase additional cartridges, see Accessories on page 67

⚠ CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices. Avoid touching pins, leads and circuitry.

ernote: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip. Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at: http://www.hp.com/go/learnaboutsupplies.

Storage of anonymous usage information

Each ink cartridge contains a memory chip that assists in the operation of the printer.

The memory chip stores a limited set of anonymous information about the usage of the printer, which can include the following: the date when the cartridge was first installed, the date when the cartridge was last used, the number of pages printed using the cartridge, the page coverage, the frequency of printing, the printing modes used, any printing errors that may have occurred, and the product model. This information helps HP to design future products to meet our customers' printing needs.

The data collected by the memory chip does not include information that could be used to identify a customer or user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling program (HP Planet Partners: http://www.hp.com/recycle). The sampled memory chips are read and studied in order to improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the data. Any third party possessing the cartridge may be able to access the anonymous information on the memory chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip's ability to collect printer usage information. To do so, access the front panel and tap ☰, then Preferences►Automatically send printer data, or access the Embedded Web Server, and click Settings►Preferences►Data Collection settings. This does not prevent the cartridge from working normally in other respects. However, if you change your mind later, you can restore the factory defaults to resume collecting printer usage information.

Check ink cartridge status

Information about the evolution of the ink cartridges.

To view the ink levels of your ink cartridges, swipe down the dashboard and tap ☰ on the front panel. For more information, tap the specific cartridge.
You can also get this information from the HP Utility (Windows only):

- In the EWS go to **Home** ► **Estimated Cartridges Levels** or **Tools** ► **Supply Status**; In the HP DesignJet Utility, go to the **Supplies** tab to see each cartridge's status.

For an explanation of the ink cartridge status messages, see *Ink cartridge status messages on page 88*.

**Replace an ink cartridge**

There are two occasions when you need to replace an ink cartridge.

- The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can use up the remaining ink in the first cartridge at a more convenient time).
- The ink cartridge is empty or faulty, and you must replace it to continue printing.

⚠️ **CAUTION:** Do not try to remove an ink cartridge while printing.

⚠️ **CAUTION:** Remove an ink cartridge only if you are ready to insert another one.

⚠️ **NOTE:** When a cartridge runs out of ink, the current job is cancelled.

1. Make sure the printer is turned on.
2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.
3. Open the window.
4. Press the ink cartridge to unlock it.
5. Remove the ink cartridge.

6. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the same colored letter as the cartridge you are installing.

7. Close the window.

About the printhead

The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink onto the paper.

⚠️ CAUTION: Observe precautions when handling the printhead, because it is an ESD-sensitive device. Avoid touching pins, leads, and circuitry.

For information on replacing printheads, see Replace the printhead on page 61.

Safe mode

Under certain conditions, including printer operation outside of environmental specifications, and when a used, refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode.
HP is unable to warrant the performance of the printing system when operated outside of environmental specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the printheads from damage due to unexpected conditions, and is in operation when the icon is displayed on the printer's front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including original HP inks and printheads, are designed and engineered together to provide uncompromising print quality, consistency, performance, durability, and value—with every print.

**NOTE:** This printer is not designed to use continuous ink systems. To resume printing, remove the continuous ink system and install genuine HP (or compatible) cartridges.

**NOTE:** This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or compatible) to continue printing.

**NOTE:** Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip. Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at: [http://www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies).
Maintaining the printer

Checking printer status and maintenance are essential to keep your equipment in prime condition. Keep your printer clean, diagnose issues, calibrate, replace the printhead when required, and keep your software up to date.

Check printer status

There are various ways you can check the current printer status.

- If you start the HP Utility (Windows only) and select your printer, you see a page of information describing the status of the printer and its paper and ink supplies.
- If you access the Embedded Web Server, you see information about the general status of the printer.
- From the front panel, you can get information about the loaded paper and the ink levels.

Take care of the printer

The printer is not designed for any purpose other than printing. It is not recommended to use the printer as a table, for two reasons:

- The surface can easily be damaged.
- Anything that falls into the printer can cause more serious damage.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal operation with a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

⚠️ WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you clean it. Do not let water get inside the printer.

⚠️ CAUTION: Do not use abrasive cleaners on the printer.

Print Quality Diagnostic Report

There are two test patterns designed to highlight printhead reliability problems.

To print the Print Quality Diagnostic Report

Check the performance of the printhead that is currently installed in your printer, and whether it suffers from clogging or alignment problems.

1. Use the same paper type that you were using when you detected a problem. The test patterns are easiest to evaluate on plain white paper.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View information about the paper on page 30.

3. At the printer’s front panel, tap then Image Reports > Print Quality Report.
Corrective actions

If you have an issue with the diagnostic page, there are steps you can take, depending on the problem.

1. If the lines in Test Pattern 1 are not straight and connected, align the printhead (see Align the printhead on page 60).

2. If any of the colored blocks in Test Pattern 2 show white lines, are faded or completely missing, clean the printhead (see Clean the printhead on page 59). Follow the front-panel prompts and perform all three levels of cleaning if necessary.

3. If the problem remains, clean the printhead again.

4. If the problem remains, replace the ink cartridge (see Replace an ink cartridge on page 55) corresponding to the streaked, faded, or missing color block in Test Pattern 2.

5. If the problem remains, replace the printhead (see Replace the printhead on page 61). If the printhead is still in warranty, contact HP Support (see Contact HP Support on page 101).

Clean the printhead

If your print is streaked or has incorrect or missing colors, the printhead may need to be cleaned.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and uses an increasing amount of ink. After each stage, review the quality of the printed page. You should initiate the next phase of cleaning only if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printhead.

NOTE: Cleaning uses ink, so clean the printhead only when necessary.

NOTE: Failing to turn off the printer correctly can cause print-quality problems.
Clean the printhead from the front panel

When your print quality seems poor, and you are next to the printer, this is a simple method to address the issue.

1. Make sure there is paper in the input tray or a roll loaded.
2. Go to the front panel and tap \(\text{Printer Maintenance}\) \(\text{Clean the Printhead}\).

Clean the printhead from the Embedded Web Server

You can clean the printhead remotely using an ordinary Web browser running on any computer.

1. Make sure there is paper in the input tray or a roll loaded.
2. In the \text{Tools} tab on the Embedded Web Server, then tap \text{Tools} \(\text{Utilities}\) \(\text{Print Quality Toolbox}\) \(\text{Clean Printhead}\), and follow the instructions on the screen.

Clean the printhead from the HP Utility (Windows only)

You can manage this and clean the printhead from a computer with a USB, TCP/IP, or Wi-Fi connection.

1. Make sure there is paper in the input tray or a roll loaded.
2. In the \text{Support} tab of the HP Utility, click \text{Printhead Cleaning}, and follow the instructions on the screen.

Align the printhead

Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in graphical elements.

Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced. You may need to align the printhead after a paper jam or if you are experiencing print-quality problems.

\begin{itemize}
  \item \textbf{IMPORTANT:} Load A4 and letter in portrait. Do not load them in landscape.
  \item \textbf{CAUTION:} Do not use transparent or semi-transparent paper to align the printhead.
  \item Ensure that the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.
  \item From the front panel, tap \(\text{Printer Maintenance}\) \(\text{Align the Printhead}\).
  \item \textbf{NOTE:} Printhead alignment can also be started from the Embedded Web Server \((\text{Tools} \text{Utilities} \text{Print Quality Toolbox} \text{Optimize and Improve} \text{Align Printhead})\), or from the HP Utility \((\text{Windows: Support} \text{Printhead Alignment})\); \text{Mac OS X: Information and Print Quality > Align}).
  \item If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.
  \item The process takes about five minutes. Wait until the front-panel display shows the process complete before using the printer.
\end{itemize}

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead and try again.
Replace the printhead

When the printhead is out of ink or has an issue that cannot be fixed, you must replace it. After replacement, the printer will automatically perform a printhead alignment on the loaded paper.

**TIP:** If you would like to perform the printhead alignment on a different paper (perhaps from the multi-sheet tray), you could change the paper before starting this procedure. Plain white paper is recommended. A4 and letter paper should not be loaded in landscape orientation.

1. Make sure the printer is turned on.
2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.
3. From the front panel, tap \[ Printer Maintenance > Replace printhead. \]
4. From the front panel, tap Continue to proceed.
5. Open the main door.

6. Press each ink cartridge to unlock it.

7. Remove all the inks cartridges, then tap Next.
8. Open the printhead latch.

9. Remove the printhead, keeping it vertical to avoid getting ink on the connections.

10. Insert the new printhead.
11. When finished, close the latch and tap Next.

12. Insert the ink cartridges. Make sure that you insert each ink cartridge into the slot that has the same colored label as the cartridge you are installing.

**IMPORTANT:** If the printhead is new, install new ink cartridges. New ink cartridges are required for successful printhead replacement.

13. Close the main door.

14. The front panel recommends a printhead alignment.

**Clean the encoder strip**

You can use a small damp cloth to remove unwanted residue.

1. Turn off the printer: Press the power key and unplug the power cable.

2. Using tap water and a small cloth that will not leave fibers in the printer, dampen the cloth and remove any excess water, so that the cloth is damp but not wet.

3. Open the main door.
4. Hold the cloth in an inverted U shape around the encoder strip and carefully wipe until no further ink residue appears on the cloth. Be very careful not to scratch the encoder strip with your fingernails or any other object. Make sure that you are holding the cloth correctly.

**NOTE:** Do not move the carriage away from the service station.

5. Close the main door.

6. Turn the printer on.

**Recalibrate the paper advance**

Accurate paper advance is important to image quality because it is part of controlling the proper placement of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality issues on page 79 to determine whether paper advance calibration will solve your issue.

**Recalibrating the paper advance procedure**

The recalibration procedure takes approximately three minutes.

**TIP:** It is recommended to only have the paper loaded that you want to calibrate.

1. From the front panel, tap , then Printer Maintenance > Paper advance calibration > Calibrate ready paper. When prompted by the front panel, confirm the paper source and type. The printer automatically recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

**NOTE:** Do not worry about the paper advance calibration image.

If you are satisfied with your print, continue using this calibration for your paper type. If you see improvement in your print, continue with the next step. If you are dissatisfied with the recalibration, return to the default calibration, see Return to default calibration on page 64.

3. If you would like to fine tune the calibration, or are using a transparent paper, swipe down the dashboard and tap Image quality maintenance ▶ Paper advance calibration ▶ Adjust paper advance.

4. Select the percentage of change from –99% to +99%. To correct light banding decrease the percentage. To correct dark banding increase the percentage.

5. To save the value, tap OK on the front panel.

6. Wait until the front panel displays the status screen and reprint your print.

**Return to default calibration**

This sets all the corrections made by the paper advance calibration to zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, tap , then Printer Maintenance ▶ Paper advance calibration ▶ Reset ready paper.

2. Wait until the front panel displays the operation has completed successfully.
Move or store the printer

If you need to move the printer, take care to prepare it correctly to avoid possible damage.

To prepare the printer:

1. Do not remove the ink cartridges or printhead.
2. Make sure that no paper is loaded.
3. Turn off the printer using the Power key at the back.
4. Unplug the printer’s power cord.
5. Disconnect any cables connecting the printer to a network or a computer.

⚠️ CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare the printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off for a six weeks or more, preparing the printhead could take up to 45 minutes.

⚠️ CAUTION: If the printer remains off for a long period of time, the printhead may become unusable. In this case, you need to replace the printhead with a new one.

Firmware update

There are various ways to download and install firmware updates; choose the one you find most convenient.

🔍 NOTE: A firmware update package can be large; you may want to consider whether there are any implications for your network or Internet connection.

You can configure the printer to download firmware updates automatically whenever they become available: see Automatic firmware update on page 17.

- Using the front panel, tap ☒, then Printer Maintenance ► Update the Printer ► Check Now to check whether new firmware is available. If new firmware is available, you are given the opportunity to download and install it.
- Using the Embedded Web Server, click Tools ► Printer Updates ► Firmware Updates ► Check Now.
- Using the HP DesignJet Utility under Windows, select your printer, the Support tab, then Firmware Update.

The firmware includes a set of the most commonly used paper presets.

Software update

Manual updates of printer drivers and other software are available for your printer.


Printer maintenance kits

Three maintenance kits are available for your printer, containing components that may need to be replaced after long use.

When one of them is needed, a message is displayed on the front panel and by the HP Utility and you should contact HP Support (see ) and request the maintenance kit. The kits are installed by service engineers only.
HP Support Assistant

This helps you maintain your computer and printer. It helps you avoid or resolve issues.

The HP Support Assistant guides you to expert support when required and helps you maintain peak performance and resolve problems through automatic updates, built-in diagnostics, self-help, and a variety of assistance options. A wealth of information and support resources for your HP computers and printers is only a few clicks away.

HP Support Assistant is pre-installed on HP computers sold after October 2012, running Windows 7, Windows 8, or Windows 10 operating systems.

**NOTE:** Features may vary depending on the version installed, your computer model, and your location.

HP Support Assistant can also be installed used on non-HP computers.

If HP Support Assistant is not installed on your computer running Windows 7, Windows 8, or Windows 10, you can download the latest version by selecting it on the printer driver installer package, or clicking: [http://www.hp.com/go/hpsupportassistant](http://www.hp.com/go/hpsupportassistant).
10 Accessories

Supplies and accessories can be ordered for your printer.

How to order supplies and accessories

There are two ways to order supplies or accessories for your printer.

- Contact HP Support (see HP Support Center on page 100).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

Ink cartridges can be ordered singularly or in packs of 3. There is also a printhead replacement kit you can order for your printer.

<table>
<thead>
<tr>
<th>Cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 712 29ml Cyan DesignJet Ink Cartridge</td>
<td>3ED67A</td>
</tr>
<tr>
<td>HP 712 29ml Magenta DesignJet Ink Cartridge</td>
<td>3ED68A</td>
</tr>
<tr>
<td>HP 712 29ml Yellow DesignJet Ink Cartridge</td>
<td>3ED69A</td>
</tr>
<tr>
<td>HP 712 38ml Black DesignJet Ink Cartridge</td>
<td>3ED70A</td>
</tr>
<tr>
<td>HP 712 80ml Black DesignJet Ink Cartridge</td>
<td>3ED71A</td>
</tr>
<tr>
<td>HP 712 Cyan DesignJet Ink Cartridge 3-Pack</td>
<td>3ED77A</td>
</tr>
<tr>
<td>HP 712 Magenta DesignJet Ink Cartridge 3-Pack</td>
<td>3ED78A</td>
</tr>
<tr>
<td>HP 712 Yellow DesignJet Ink Cartridge 3-Pack</td>
<td>3ED79A</td>
</tr>
<tr>
<td>HP 712B 38ml Black DesignJet Ink Cartridge</td>
<td>3ED28A</td>
</tr>
<tr>
<td>HP 712B 80ml Black DesignJet Ink Cartridge</td>
<td>3ED29A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printhead</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 713 DesignJet Printhead Replacement Kit</td>
<td>3ED58A</td>
</tr>
</tbody>
</table>

Order paper

HP printers can use a wide range of paper.

To check the latest information related to papers supported by your printer, go to: http://www.hplfmedia.com.
Order accessories

There are accessories available for your printer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Product number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T200/T600 Roll Cover</td>
<td>9GF94A</td>
</tr>
<tr>
<td>HP DesignJet T200/T600 Automatic Sheet Feeder</td>
<td>8AJ60A</td>
</tr>
<tr>
<td>HP DesignJet T200/T600 24-in Printer Stand</td>
<td>3C753A</td>
</tr>
<tr>
<td>HP DesignJet 24-in Spindle</td>
<td>B3Q36A</td>
</tr>
<tr>
<td>HP DesignJet 36-in Spindle</td>
<td>B3Q37A</td>
</tr>
</tbody>
</table>

Introduction to the accessories

You can increase your printer’s possibilities with accessories.

Automatic sheet feeder

The automatic sheet feeder is only provided with the T600 series, it is not provided by the T200 series but may be purchased as an accessory. It allows you to send to print multiple sheet sizes (A4/A & A3/B) without manually switching the media source (sheet to roll).

Roll cover

The roll cover is provided with specific models of the T600 series only, but may be purchased as an accessory. It allows for a more integrated design, and protects loaded media from dust and external agents.

Stand

The stand is provided with the T600 Printer Series. It is not provided with the T200 Printer Series, but may be purchased as an accessory.

Spindle

With extra spindles, you can quickly change from one paper type to another.
11 Troubleshooting paper issues

Step by step instructions are provided to help you identify and resolve paper issues.

Paper cannot be loaded successfully

There are various reasons why you may have issues loading the paper.

- Ensure that no paper is already loaded.
- Ensure that the paper is far enough inside the printer, you should feel the printer grab the paper.
- Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-panel display. The printer automatically attempts to straighten the paper.
- The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load

There are checks to make and steps to correct any problems.

- Check that the roll is at least 280 mm (11 in) wide: narrower rolls are not supported.
- Check the leading edge of the paper: if it is not straight or clean, it should be trimmed. Remove the initial 20 mm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.
- Check that the roll ends are tight against the spindle ends.
- Check that the spindle is correctly inserted.
- Check that the output tray is closed. The roll will not load when it is open.
- Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
- Check that all roll end plugs have been removed.
- Check that the paper is wound tightly on the roll.
- Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, follow the instructions on the front panel.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from the end of the spindle until the edge is removed from the printer.

**NOTE:** If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

There are checks to make and steps to correct any problems.

- Check that the sheet is more than 329 mm (12.95 in) wide (A3+). If it is that width or less, load it from the multi-sheet tray.
- Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
- Ensure that the sheet is aligned with the reference line on the roll cover.
Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel display.

Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the sheet from the front of the printer.

**Unsuccessful load from the multi-sheet tray**

There are checks to make and steps to correct any problems.

- Check that you have not loaded too many sheets into the tray. The maximum number of sheets depends on the paper thickness: around 50 sheets of plain, standard paper.
- Check that the sheets are correctly loaded into the tray.
- Check that the sheets are correctly adjusted and centered in the tray.
- Check that you have extended the input and output trays correctly: the first extension for A4, the second for A3 paper.

If the paper is hanging over the back of the input tray as shown, it may fail to load.
NOTE: Try to avoid leaving sheets of paper loaded in the printer for a significant length of time, because they will deform.

Paper loading error messages

There is a list of front-panel messages related to paper loading, with the suggested corrective action.

Table 11-1 Error Messages

<table>
<thead>
<tr>
<th>Front-panel message</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper loaded with too much skew</td>
<td>During the paper load process the printer detected that the paper had too much skew. Tap OK to unload the roll automatically, then restart the process.</td>
</tr>
<tr>
<td>Paper not detected</td>
<td>During the paper load process the printer did not detect any paper. Ensure the paper is inserted fully and is not transparent.</td>
</tr>
<tr>
<td>Paper too far from lateral edge</td>
<td>Reload the cut sheet, aligning the right edge against the black stop on the spindle.</td>
</tr>
<tr>
<td>Paper load failed. Paper width is smaller than the minimum size supported by the selected paper source.</td>
<td>Cut sheets smaller than ISO A3 must be loaded using the multi-sheet tray.</td>
</tr>
<tr>
<td>Sheet too big</td>
<td>During the load process the printer has detected that the sheet of paper is either too wide or too long to be loaded correctly. Tap to stop the load process. See Functional specifications on page 103.</td>
</tr>
<tr>
<td>Sheet too small</td>
<td>During the load process the printer detected that the sheet of paper is too narrow or too short to be loaded in the printer. Tap to stop the load process. See Functional specifications on page 103.</td>
</tr>
</tbody>
</table>

Paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, however, you must identify whether your paper is transparent or translucent, photo or bond, coated or technical.

NOTE: For glossy paper, it is important to select a glossy paper type, as the printer adjusts its use of ink for glossy paper.

Transparent or translucent film

You may use clear or matte film.

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear film.
If your paper is a translucent paper or film (for example, technical paper), select paper type Film > Matte film.

**Photo paper**

There are different types of photo paper finishes that you can apply.

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper type Photo Gloss Paper. For Semi-gloss, Satin, Pearl, or Luster finishes, select paper type Photo Semi-gloss/Satin Paper.

To increase gamut on photo paper, select paper type HP Universal Gloss Photo Paper or HP Universal Satin Photo Paper, depending on the finish.

**Bond and coated or technical paper**

Your paper type selection for generic paper depends on the paper’s ink absorption capacity.

- For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m² or Natural Tracing Paper > 65 g/m², depending on the weight of the paper.
- For thin papers (< 90 g/m²) or uncoated papers (for example plain paper or bright white paper), select paper type Bond and Coated Paper > Plain Paper. You can also select Recycled Bond Paper.
- For light coated papers (< 110 g/m²), select paper type Bond and Coated Paper > HP Coated Paper.
- For heavyweight coated papers (< 200 g/m²), select paper type Bond and Coated Paper > Heavyweight Coated Paper.

**Black ink is easily removed when touched**

This happens when your paper is incompatible with matte black ink.

To use an optimized ink combination, select paper type Photo Paper > Photo Gloss Paper.

**After printing, the paper has wrinkles or there is too much ink**

This happens when too much ink is used.

To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:

- Plain Paper
- Coated Paper
- Heavyweight Coated Paper

For other print-quality problems, see Troubleshooting print-quality issues on page 79.

**Printer printed on the wrong paper type**

This happens when the printer prints your job before you were able to load your desired paper.

You may have Use printer settings selected for the Paper Type in the printer driver.

When Use printer settings is selected the printer will print immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 26, and select your paper type specifically in the driver.

- In the Windows driver dialog: Select your paper type from the Paper Type list.
- In the Mac OS X Print dialog: Select the Paper/Quality panel, then from the Paper Type list, select your paper type.
NOTE: Use printer settings is the driver default.

Paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job, the printer stops and waits for you to decide what to do. There are several ways in which the loaded paper may be considered unsuitable.

- The paper type is not as specified for the job.
- The paper source (roll, multi-sheet tray, or manual feed) is not as specified for the job.
- The paper size is smaller than specified for the job.

If you do not specify these things for a particular job, the printer will print on whatever paper is loaded.

- Load the correct paper and resume printing.
- Print the job on the already-loaded paper. The print may be clipped if the paper is not large enough.
- Cancel the job.

Roll has jammed

When a paper jam occurs, you normally see a message about it in the front-panel display.

1. Open the roll cover.

2. Open the main door.
3. Rewind the roll to create a loop. Cut the paper, if needed.

4. Carefully remove any of the jammed paper that you can from the top of the printer.

5. Carefully remove any of the jammed paper from the front window.

6. Reload the roll, or load a new sheet; see Paper handling on page 26.

**NOTE:** If you find that there is still some paper causing an obstruction within the printer, restart the procedure and carefully remove all pieces of paper. You may need to remove the multi-sheet tray (see Multi-sheet tray has jammed on page 75).

**Prevent a jam**

Depending on substrate type, roll condition, environmental conditions, image content, print mode etc. a jam may be prevented by opening the main door halfway.
Multi-sheet tray has jammed

Paper can jam in the multi-sheet tray for a variety of reasons and there are steps to follow to correct an issue.

Proceed as follows:

1. Remove as much paper as you can from the multi-sheet tray.
2. Push down the multi-sheet tray extensions, which will make the tray easier to handle.
3. Unlock the tray, using the rotary switch behind it.

4. Pull out the tray.

5. Remove all paper from the tray.

6. Put the tray in again.
7. Lock the tray.

---

A strip stays on the output tray and generates jams

If a small piece of paper has been cut, such as before printing a new roll, or after the front panel option Form feed and cut has been used, the cut strip may remain in the output tray. Only when the printer is not printing, reach into the tray and remove the strip.

---

Printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If possible, tighten the paper to its core or load a new roll.

---

Prints do not fall neatly into the bin

There are steps you can follow if there is an issue with the bin.

- Ensure the bin is correctly installed.
- Ensure the bin is open.
- Ensure the bin is not full.
- Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or remove prints manually as they are completed.

---

Sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing.

See Change the drying time on page 31. If the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in the front panel, see Form feed and form feed and cut on page 32.
Paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed. You can disable the cutter.
See Change the drying time on page 31. You can disable the cutter, see Turn the automatic cutter on and off on page 31.

Cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed.
If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles, and check that there are no pieces of paper in the cutter groove.

Roll is loose on the spindle

The roll may need to be replaced or reloaded.
12  Troubleshooting print-quality issues

Step by step instructions are provided for you to identify and resolve your issue.

General printing advice

To achieve the best performance from your printer, use only genuine manufacturer’s supplies and accessories.

- Genuine manufacturer’s supplies and accessories have been thoroughly tested to give trouble-free performance and best-quality prints. For details of recommended papers, see Order paper on page 67.
- Make sure that the paper type selected in the front panel is the same as the paper type loaded into the printer (see View information about the paper on page 30). Also make sure that the paper type selected in your software is the same as the paper type loaded into the printer.

⚠️ CAUTION: If you have the wrong paper type selected, you could experience poor print quality and incorrect colors, and perhaps even damage to the printhead.

- Check that you are using the most appropriate print-quality settings for your purposes (see Printing on page 33). You are likely to see lower print quality if you have set the quality level to Fast.
- Check that your environmental conditions (temperature, humidity) are in the recommended range. See Environmental specifications on page 106.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary).

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 30.
2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 33). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality level to Fast, try setting it to Best.
3. Print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 58.
4. If the printhead is working correctly, perform paper advance calibration: see Recalibrate the paper advance on page 64.

If the problem persists despite all the above actions, contact your customer service representative for further support.
Lines are too thick, too thin or missing

Check the paper type and settings, and run a report.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 30.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 33). Try turning on the Maximum detail option (if available under the Color and Quality settings).

3. If lines are too thin or missing, print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 58.

4. If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 64.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Lines appear stepped or jagged

Check your original image, and print-quality settings.

1. The problem may be inherent in the image. Try to improve the image with the application you are using to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 33.

3. Turn on the Maximum detail option (if available under the Color and Quality settings).

Lines print double or in the wrong colors

This problem can have various visible symptoms.

- Colored lines are printed double, in different colors.
The borders of colored blocks are wrongly colored.

To correct this kind of problem, print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print the Print Quality Diagnostic Report on page 58.

Lines are discontinuous

Check your print-quality settings and print a Print Quality Diagnostic Report.

1. Check that you are using appropriate print-quality settings. See Printing on page 33.
2. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print the Print Quality Diagnostic Report on page 58.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy.

Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing. See Environmental specifications on page 106.
2. Check that the paper type selected in the front panel is the same as the paper type you are using. See View information about the paper on page 30.
3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.

4. Select a lower print quality (such as Fast); the printer will then use less ink.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper.

6. If you are using glossy paper, try changing to a different type of glossy paper.

7. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print the Print Quality Diagnostic Report on page 58.

**Line lengths are inaccurate**

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes, you can try to improve line length accuracy.

Try the following:

1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional specifications on page 103.
   Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set Print Quality to Best.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance on page 64.

**Whole image is blurry or grainy**

There are a series of steps and checks you can make to deal with this issue. Check the paper, settings, run reports to find the issue etc.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 30.

2. Check that you are printing on the correct side of the paper.
3. Check that you are using appropriate print-quality settings (see Printing on page 33). In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality to Fast, try using Best.

4. Print the Print Quality Diagnostic Report, and align the printhead if recommended in the report. See To print the Print Quality Diagnostic Report on page 58.

5. If the problem remains, perform paper advance calibration: see Recalibrate the paper advance on page 64.

If the problem persists despite all the above actions, contact your customer service representative for further support.

Paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes saturated with ink.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 30.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

3. Select a lower print quality (such as Fast); the printer will then use less ink.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper.

Print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after printing, depending on the amount of ink used and the environmental conditions at the time of printing.

- Handle prints carefully.
- Avoid stacking prints on top of each other.
- Catch your prints as they are cut from the roll and do not let them fall into the bin. Alternatively, leave a sheet of paper in the bin so that freshly printed sheets do not make direct contact with the bin.
- Increase the drying time. At the front panel, tap setup, then Print Settings > Drying Time > Extended.
Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printhead moves over the paper, the printhead may come into contact with the paper and smear the printed image.

This problem is normally seen only on cut sheets of paper (not on roll paper).

Whenever you notice this problem, cancel the printing job immediately. Tap and also cancel the job from your computer application. Soaked paper can damage the printhead.

If you notice poor print quality after this has happened, clean the printhead. See Clean the printhead on page 59.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your software. See View information about the paper on page 30.
2. Use a recommended paper type (see Order paper on page 67) and the correct print settings.
3. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect performance.
4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.
5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, Heavyweight Coated Paper.
6. Try to increase the margins by relocating the image to the center of the page using your software application.

Ink marks on the back of the paper

Clean the platen with a soft cloth. Clean each rib separately.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte black ink if it knows that the paper will not retain it.

To be sure of avoiding matte black ink, you can select Photo Glossy Paper as the paper type (in the Photo Paper category).

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the print-quality slider to Best.
Edges of objects are darker than expected

If edges of objects seem darker than expected, and you have already set the print-quality to Best, try setting the quality to Fast.

See Printing on page 33 for more information.

Vertical lines of different colors

If your print has vertical bands of different colors along it try changing the paper and/or adjusting the print-quality settings.

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated Paper. See Order paper on page 67.
2. Try using higher print-quality settings (see Printing on page 33). For instance, if you have set the Print Quality to Fast, try setting it to Best.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material.

To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.
3. Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, there are steps you can take.

Try the following:
1. Check that the paper type you have loaded corresponds to the paper type selected.
2. Check that you are printing on the correct side of the paper.
3. Check that you are using appropriate print-quality settings. For the most accurate colors, select Normal or Best quality.
4. Print the Print Quality Diagnostic Report. See To print the Print Quality Diagnostic Report on page 58.

Colors are fading
If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.
Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints (depending on the type of lamination) with all paper types. For more information, consult your laminate provider.

Image is incomplete (clipped at the bottom)
If the image is incomplete you may have cut the data being received, or there could be a communication issue.
- Did you tap Cancel before all the data were received by the printer? If so, you have ended the data transmission and will have to print the page again.
- There may be a communications problem between your computer and the printer. Check your USB or network cable, or your Wi-Fi connection.
- Check to make sure that your software settings are correct for your current page size (for example, long-axis prints).
- If you are using network software, make sure it has not timed out.

Image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the printable area as understood by your software.
- Check the actual printable area for the paper size you have loaded.
  \[
  \text{printable area} = \text{paper size} - \text{margins}
  \]
- Check what your software understands to be the printable area (which it may call "printing area" or "imageable area"). For example, some software applications assume standard printable areas that are larger than those used in this printer.
- If you have defined a custom page size with very narrow margins, the printer may impose its own minimal margins, clipping your image slightly. You may want to consider using a larger paper size.
- If your image contains its own margins, you may be able to print it successfully by using the Clip Contents by Margins option (see Select margins options on page 39).
- If you are trying to print a very long image on a roll, check that your software is capable of printing an image of that size.
- You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.
- If necessary, reduce the size of the image or document in your software application, so it fits between the margins.
Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific workflows there may be issues that can lead to some objects missing from the output.

Here are some suggestions to help you to avoid this problem:

- Select a smaller page size and scale to the desired final page size in the driver or in the front panel.
- Save the file in another format, such as TIFF or EPS, and open it with another application.
- Reduce the resolution of bitmap images in your application software.

**NOTE:** If you’re using Adobe applications, ensure that you have installed the latest version.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to solve the problem.

If you still have a problem

If you still experience print-quality problems after applying the advice then there are other steps you can try.

Here are some further things that you can do:

- Try using a higher print-quality option. See Printing on page 33.
- Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded from http://www.hp.com/go/DesignJetT200/software or http://www.hp.com/go/DesignJetT600/software.
- Check that your printer’s firmware is up to date. See Firmware update on page 65.
- Check that you have the right settings in your software application.
13 Troubleshooting ink cartridge and printhead issues

Step by step instructions are provided for you to identify and resolve your issue.

Cannot insert an ink cartridge

It is important that you are using the correct type of cartridge, and that it is well placed in its slot.

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.
3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side up and readable.

⚠️ CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

There are ink cartridge status messages to alert you to an issue.

- **OK**: The cartridge is working normally, with no known problems.
- **Missing** or **Damaged**: There is no cartridge present, or it is not correctly connected to the printer (shown with an X on the status screen).
- **Low**: The ink level is low.
- **Out of ink**: The cartridge is empty.
- **Not genuine HP**: The cartridge is not a genuine HP cartridge.
- **Wrong slot**: The cartridge has been inserted into the wrong slot.
- **Incompatible**: The cartridge is incompatible with this printer.

Cannot insert the printhead

It is important that you are using the correct type of printhead, and that it is well placed in its slot.

1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the orange protective cap from the printhead.
3. Check that the printhead is correctly oriented.
4. Check that you have correctly latched the printhead, see Replace the printhead on page 61.
14 Troubleshooting data communication issues

Step by step instructions are provided for you to identify and resolve your issue.

Communication failures between computer and printer

Some symptoms are apparent when there is an issue.

- The front-panel display does not show the **Printing** message when you have sent an image to the printer.
- Your computer displays an error message when you are trying to print.
- Your computer or printer hangs (stays idle), while communication is taking place.
- Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)
- Ensure that you have selected the correct printer in your application, see Printing on page 33.
- Ensure that the printer works correctly when printing from other applications.
- Remember that very large prints may take some time to receive, process and print.
- If the printer is connected to a network, check the printer connectivity status: the printer should have an IP address and it should match the IP address specified in the printing computer. If the addresses do not match, then configure it correctly; if the issue persists, check your network configuration or try connecting to the printer by USB cable.
- Try another interface cable.
- If the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also try using a different USB port on the computer.
- If the printer is connected to a wireless network, you can request a diagnostic report from the front panel: tap \[\text{\textregistered}\] or \[\text{\textregistered}\], then **Settings > Print Wireless Network Test**. Alternatively, try moving the printer closer to the wireless router, or try connecting the printer by wired network or USB cable.
- Increase the lease time of your DHCP server device.
- Set a fixed IP address for your printer that will not be changed by DHCP.
- Configure the printer and driver to refer to the hostname instead of the numeric IP address.

Fixed IP

Set a fixed IP address for the printer from the front panel.

1. Go to the front panel and tap \[\text{\textregistered}\] or \[\text{\textregistered}\].
2. At the bottom of the screen, tap **Settings > Advanced setup > IP settings > OK > Manual** and enter the IP address, the subnet mask, and the gateway (those settings should be provided by your network administrator).

Hostname

You can use the hostname instead of the numeric IP address.
1. Go to the front panel and tap or.

2. Take a note of the IP address and the hostname (HPXXXXXX format).

3. If your computer is running Windows, go to Control Panel > Printers, right-click the printer and click Properties > Ports > Configure Port, and in the Printer name or IP address field enter the hostname.

Wired network issues

If you are unable to install the HP software provided with the printer, then you need check some things.

Check that:

- All cable connections to the computer and the printer are secure.
- The network is operational and the network hub is turned on.
- All applications, including virus protection programs, spyware protection programs, and firewalls, are closed or disabled for computers running Windows.
- The printer is installed on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the network configuration page, and enter the IP address manually in the installation program. For more information, see Network configuration page on page 93.

Though it is not recommended that you assign a static IP address to the printer, you might resolve some installation problems (such as a conflict with a personal firewall) by doing so. See Communication failures between computer and printer on page 89.

Network port created does not match printer IP address (Windows)

If you are using a computer running Windows, make sure that the network ports created in the printer driver match the printer's IP address.

1. Print the printer’s network configuration page.

2. Click Start, point to Settings, then click Printers or Printers and Faxes.

- or –

Click Start, click Control Panel, then double-click Printers.

3. Right-click the printer icon, click Properties, and then click the Ports tab.

4. Select the TCP/IP port for the printer, and then click Configure Port.

5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed on the network configuration page. If the IP addresses are different, change the IP address in the dialog box to match the address on the network configuration page.

6. Click OK twice to save the settings and close the dialog boxes.

Wireless network issues

Step by step instructions are provided for you to identify and resolve your issue.

Wireless network troubleshooting

Check that the wireless is on, that there are no issues with cable connections or the network.
1. Make sure the wireless (802.11) light at the top left of the front panel is turned on. If the blue light is not lit, the wireless capabilities may not have been turned on. To turn on wireless, tap then *Settings > Wireless > On.*

2. Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet cable turns off the printer's wireless capabilities.

3. Restart components of the wireless network.
   
   Turn off the router and the printer, and then turn them back on in this order: router first and then the printer. If you still are unable to connect, turn off the router, printer, and your computer. Sometimes, turning off the power and then turning it back on can solve a network communication issue.

4. Run the Wireless Network Test.
   
   For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test page, tap then *Settings > Print Wireless Network Test.* If a problem is detected, the printed test report includes recommendations that could help to solve the problem.

**Advanced wireless network troubleshooting**

If you have tried to fix the problem, and are still unable to connect to your printer to the wireless network, then there are steps you can take.

Try the following:

1. Make sure that your computer's wireless networking has been turned on. For more information, see the documentation that came with your computer.

2. If you are not using a unique network name (SSID), then it is possible that your computer could be connected to a nearby network that is not yours. The following steps can help you to determine whether your computer is connected to your network.

   **Windows:**
   
   a. Click ![Start]Start. click ![Control Panel](control_panel.png) point to ![Network Connections](network_connections.png), then click ![View Network Status and Tasks](view_network_status_and_tasks.png).
      
      — or —

      Click ![Start](start.png), then ![Settings](settings.png), click ![Control Panel](control_panel.png), double-click ![Network Connections](network_connections.png), click the ![View](view.png) menu, then select ![Details](details.png).

      Leave the network dialog box open while you continue to the next step.

   b. Disconnect the power cord from the wireless router. The connection status of your computer should change to ![Not Connected](not_connected.png).

   c. Reconnect the power cord to the wireless router. The connection status should change to ![Connected](connected.png).

   **Mac OS X:**
   
   ▲ Click ![Wi-Fi](wifi.png) in the menu bar at the top of the screen. From the menu that appears, you can determine if the Wi-Fi is turned on and which wireless network your computer is connected to.

   ★ **TIP:** For more detailed information about your Wi-Fi connection, click ![System Preferences](system_preferences.png) in the Dock. If the wireless connection is working correctly, a green dot appears next to the list of connections. For more information, click the ![Help](help.png) button in the window.
If you are unable to get your computer connected to your network, contact the person/company that set up your network or the router manufacturer as there may be a hardware issue with your router or computer.

3. Print the printer’s Wireless Configuration page (see Network configuration page on page 93). After the page has been printed, check the Network Status and URL. The Network Status is **Ready** if the printer is actively connected to a network, or **Offline** if it is not (in the latter case, run the Wireless Network Test). The URL is the network address assigned to the printer by your router; you need it to connect to the printer’s Embedded Web Server.

4. If you have established that the computer and the printer both have active connections to a network, you can check whether they are on the same network by trying to access the printer’s Embedded Web Server (see Access the Embedded Web Server on page 20).

5. If you cannot access the Embedded Web Server and are sure that both the computer and printer have active connections to the same network, the **firewall** security software could be blocking communication. Temporarily turn off any firewall security software running on your computer, and try to access the Embedded Web Server again. If you can access it, try using the printer for printing.

If you are able to access the Embedded Web Server and use your printer with the firewall turned off, you need to reconfigure your firewall settings to allow the computer and printer to communicate with each other over the network.

If you are able to access the Embedded Web Server, but are still unable to use the printer even with the firewall turned off, try enabling the firewall software to recognize the printer.

6. If you have the HP software installed, you can check the printer’s status from your computer to check whether the printer is paused or offline, preventing you from using it.

   **Windows:**
   a. Click **Start**, point to **Settings**, then click **Printers** or **Printers and Faxes**.
      – or –
   b. Click **Start**, click **Control Panel**, then double-click **Printers**.
   c. Do one of the following, depending on the printer status:
      ● If the printer is **Offline**, right-click the printer, and click **Use Printer Online**.
      ● If the printer is **Paused**, right-click the printer, and click **Resume Printing**.
   d. Try using the printer over the network.

   **Mac OS X:**
   a. Click **System Preferences** in the dock, then click **Printers & Scanners**.
   b. Select the printer, then click **Print Queue**.
   c. If **Jobs Stopped** appears in the resulting window, click **Start Jobs**.

7. If you install the HP software a second time, the installer may create a second version of the printer driver in your Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or connecting to the printer, make sure the correct version of the Windows printer driver is set as the default.

   a. Click **Start**, point to **Settings**, then click **Printers** or **Printers and Faxes**.
      – or –
Click Start, click Control Panel, then double-click Printers.

b. Right-click the printer icon, and then click Properties. Document Defaults, or Printing Preferences.

c. On the Ports tab, look for a port in the list with a checkmark. The version of the printer driver that is connected wirelessly has Standard TCP/IP Port as the Port description, next to the checkmark.

d. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and click Set as Default Printer.

8. Try restarting the HP Network Device Support service (Windows only).

   a. Delete any print jobs currently in the print queue.

   b. On the desktop, right-click My Computer or Computer, then click Manage.

   c. Double-click Services and Applications, then click Services.

   d. Scroll down the list of services, right-click HP Network Devices Support, then click Restart.

   e. After the service restarts, try using the printer over the network again.

If you are able to use the printer over the network, your network setup was successful.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, your firewall may be interfering, or there may be a problem with your network configuration or router. Contact the person who set up your network or the router manufacturer for help.

Add hardware addresses to a wireless access point (WAP)

MAC filtering is a security feature in which a WAP is configured with a list of MAC addresses (also called “hardware addresses”) of devices that are allowed to gain access to the network through the WAP.

If the WAP does not have the hardware address of a device attempting to access the network, the WAP denies the device access to the network. If the WAP filters MAC addresses, then the printer’s MAC address must be added to the WAP’s list of accepted MAC addresses.

1. Print the network configuration page. For more information, see Network configuration page on page 93.

2. Open the WAP’s configuration utility, and add the printer’s hardware address to the list of accepted MAC addresses.

Mobile Printing issues

For issues, visit the links listed here.


Also see http://www.hpsmart.com.

Network configuration page

If the printer is connected to a network, you can print a network configuration page to view the network settings for the printer.

You can use the network configuration page to help troubleshoot network connectivity problems. If you need to call HP, it is often useful to print this page before calling. To print the network configuration page from the front panel: tap , then Internal Prints > User Information Prints > Network Configuration Page.
1. **General Information:** Shows information about the current status and active connection type of the network, and other information, such as the URL of the Embedded Web Server.

2. **802.3 Wired:** Shows information about the active wired network connection, such as the IP address, subnet mask, default gateway, and hardware address of the printer.

3. **802.11 Wireless:** Shows information about your wireless network connection, such as the hostname, IP address, subnet mask, default gateway, and server.

4. **Miscellaneous:** Shows information about more advanced network settings.
   - **Port 9100:** The printer supports raw IP printing through TCP Port 9100. This HP-proprietary TCP/IP port on the printer is the default port for printing. It is accessed by HP software (for example, the HP Standard Port).
   - **LPD:** Line Printer Daemon (LPD) refers to the protocol and programs associated with line-printer spooling services that may be installed on various TCP/IP systems.

     **NOTE:** The LPD functionality can be used with any host implementation of LPD that complies with the RFC 1179 document. The process for configuring printer spoolers, however, might differ. See your system documentation for information about configuring these systems.

   - **Bonjour:** Bonjour services (which use mDNS, or Multicast Domain Name System) are typically used on small networks for IP address and name resolution (through UDP port 5353), where a conventional DNS server is not used.
   - **SLP:** Service Location Protocol (SLP) is an Internet standard network protocol that provides a framework to allow networking applications to discover the existence, location, and configuration of networked services in enterprise networks. This protocol simplifies discovery and use of network resources such as printers, Web servers, fax machines, video cameras, file systems, backup devices (tape drives), databases, directories, mail servers, and calendars.
   - **Microsoft Web Services:** Enable or disable the Microsoft Web Services Dynamic Discovery (WS Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported on the printer. Disable unused print services to prevent access through those services.

     **NOTE:** For more information about WS Discovery and WSD Print, visit [http://www.microsoft.com](http://www.microsoft.com).

   - **SNMP:** SNMP (Simple Network Management Protocol) is used by network management applications for device management. The printer supports SNMPv1 protocol on IP networks.
   - **WINS:** If you have a Dynamic Host Configuration Protocol (DHCP) server on your network, the printer automatically obtains its IP address from that server and registers its name with any RFC 1001 and 1002–compliant dynamic name services as long as a WINS server IP address has been specified.

5. **Connected PC(s):** Lists the computers connected to this printer, as well as the last time these computers accessed the printer.
15 Troubleshooting general printer issues

Step by step instructions are provided for you to identify and resolve your issue.

Printer does not start

If the printer does not start (the front panel is blank), hold down the **Power** key for a few seconds and check whether the Power LED turns orange while the key is held down.

- If you see no orange light, no power is reaching the printer; check that the power cord is correctly plugged in. If the problem persists, call HP Support (see HP Customer Care on page 100) and explain that you have a problem with the power supply.
- If you see the orange light, wait for the printer to check if it makes a beeping sound:
  - Three beeps means an electronic problem; call HP Support and explain.

Printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file you have sent from your computer may not start printing when expected:

- You may have an electrical power problem. If there is no activity at all from the printer, and the front panel does not respond, check that the power cord is connected correctly and that there is power available at the socket.
- You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this case, turn off the printer using the **Power** key at the back and unplug the power cord, wait until the electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, contact your customer service representative.
- You may not have installed in your computer the correct driver for your printer, see the Assembly instructions.
- If you are printing on a sheet, you must specify Printer Automatic or Sheet or Tray as the paper source in your printer driver.

Printer seems slow

Here are some possible explanations:

- Did you set the print-quality to Best or Maximum detail? Best-quality and maximum detail prints take longer.
- Did you specify the correct paper type when loading the paper? Some paper types require more time for printing; for example, photo and coated papers require more drying time between passes. To find out the printer’s current paper type setting, see View information about the paper on page 30.
- If your printer is connected by network, check that all components used in the network (network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?
- Did you specify **Extended** drying time in the front panel? Try changing the drying time to **Optimal**.
- If your printer is connected by Wi-Fi, switch to a wired network.

**Front panel is frozen**

If the front panel displays a fixed image and you are unable to use it, call HP Support.

See [HP Customer Care on page 100](#).

**Cannot access the Embedded Web Server**

If you have not done so already:

Please read: [Access the Embedded Web Server on page 20](#).

**NOTE:** If you connect directly to your printer with a USB cable, you cannot access the Embedded Web Server.

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

- In Internet Explorer for Windows, go to **Tools** > **Internet Options** > **Connections** > **LAN Settings**, and check the **Bypass proxy server for local addresses** box. Alternatively, for more precise control, click the **Advanced** button and add the printer’s IP address to the list of exceptions, for which the proxy server is not used.
- In Safari for Mac OS X, go to **Safari** > **Preferences** > **Advanced** and click the **Proxies: Change Settings** button. Add the printer’s IP address or its domain name to the list of exceptions, for which the proxy server is not used, in the bypass proxy settings for the **Hosts & Domains** field.

If you still cannot connect, switch the printer off and back on with the **Power** key on the front panel.

**Restore factory defaults and settings**

If you disabled any functions or changed some settings and want to change them back, you can restore the printer to the original factory settings or network settings.

### Defaults

Restore the printer to the original factory defaults.

1. From the front panel, at the top of the screen, tap or swipe down the tab to open the dashboard, then tap  
2. Tap **Printer Maintenance**.
3. Tap **Restore**.
4. Tap **Restore Factory Defaults**.
   
   A message appears stating that the factory defaults will be restored.
5. Tap **Continue**.

### Settings

Restore the printer to the original factory settings.

**Cold Reset** removes all user configured settings, including saved administrator passwords, network configurations, stored jobs, selected country/region and language, address book entries, and web services account information.
You can use this feature if you are selling the printer, or giving it to someone else, and want to be sure that all personal information has been removed.

1. From the front panel, at the top of the screen, tap or swipe down the tab to open the dashboard, then tap  
2. Tap Printer Maintenance.
3. Tap Restore.
4. Tap Cold Reset.
   A message appears stating which settings will be restored.
5. Tap Continue.

### Alerts

Your printer can communicate two types of alerts:

- **Errors:** Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is able to print.

- **Warnings:** Alert you when the printer needs attention either for an adjustment, such as a calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

- **Front-panel display:** The front panel shows only the most relevant alert at a time. In the case of a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when the printer becomes idle and there is not another more severe alert.

- **Embedded Web Server:** The upper-right corner of the Embedded Web Server window shows the printer status. If there is an alert in the printer, the status shows the alert text.

- **Print queue:** The print queue shows alerts. The driver warns about job configuration settings that may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

- **HP Utility:** If the HP Utility is installed, alerts can be automatically displayed under Windows: a new panel opens on your screen with a list of alerts for each printer. This display of alerts can be activated on Windows by the **Alerts Settings** in the HP DesignJet Utility. You can also see the list of active alerts in the **Overview** tab of the HP DesignJet Utility.

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) as displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job from completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions to achieve your required result.

**NOTE:** There are environments that do not support bidirectional communication. In those cases, alerts do not reach the job owner.
Printer issues appear in the front panel automatically along with the recommendation of how to fix them.

**Text messages and numerical error codes**

Error messages indicate that there is a printer error that needs attention. When they appear, follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if the recommended action does not seem to solve the problem, contact HP Support. See [Contact HP Support on page 101](#).

**Table 16-1 Text messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cartridge low</td>
<td>The indicated cartridges are low. You do not have to replace the cartridge(s) now. HP recommends you have a replacement available for when the cartridge is depleted and will need to be replaced.</td>
</tr>
<tr>
<td>Cartridge very low</td>
<td>The indicated cartridges are very low and will be depleted soon. While you do not have to replace the cartridges now, HP recommends you have a replacement available for when cartridges are depleted and will need to be replaced.</td>
</tr>
<tr>
<td>Cartridges depleted</td>
<td>The indicated cartridges are depleted. Replace these cartridges.</td>
</tr>
<tr>
<td>Maintenance kit 1 required</td>
<td>Contact HP Support. See <a href="#">Contact HP Support on page 101</a>.</td>
</tr>
<tr>
<td>Maintenance kit 2 required</td>
<td>Contact HP Support. See <a href="#">Contact HP Support on page 101</a>.</td>
</tr>
<tr>
<td>Maintenance kit 3 required</td>
<td>Contact HP Support. See <a href="#">Contact HP Support on page 101</a>.</td>
</tr>
<tr>
<td>Cartridge Problem</td>
<td>Insert cartridges of the correct color as needed. See <a href="#">Replace an ink cartridge on page 55</a>.</td>
</tr>
<tr>
<td>Carriage jam</td>
<td>See <a href="#">Roll has jammed on page 73</a> or <a href="#">Multi-sheet tray has jammed on page 75</a>.</td>
</tr>
<tr>
<td>The width of the paper is smaller than the minimum size supported by the selected media source. Loading cancelled.</td>
<td>Remove the paper and load paper of the correct size.</td>
</tr>
<tr>
<td>Loaded paper is too wide. Manual unload required.</td>
<td>Remove the paper manually and load paper of the correct size.</td>
</tr>
<tr>
<td>The paper is too far from the lateral load line. Try loading the paper again.</td>
<td>Remove and reload the paper.</td>
</tr>
<tr>
<td>Please manually unload roll paper and try again.</td>
<td>Rewind the roll manually.</td>
</tr>
<tr>
<td>The currently loaded paper has too much skew and cannot be corrected automatically. Tap Remove, and then load the paper again.</td>
<td>Remove and reload the paper.</td>
</tr>
<tr>
<td>The roll is out of paper, and the current job has been cancelled. Load another roll, and then send the job again.</td>
<td>Load a new roll.</td>
</tr>
<tr>
<td>You are printing a multipage job. Load another sheet to continue printing or cancel the job.</td>
<td>Load another single sheet.</td>
</tr>
</tbody>
</table>
### Table 16-1  Text messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-sheet tray is out of paper. Load paper in multi-sheet tray and press OK to continue printing or cancel the job.</td>
<td>Load paper into the multi-sheet tray.</td>
</tr>
<tr>
<td>End of roll has been reached. It is not possible to load the roll.</td>
<td>Load a new roll.</td>
</tr>
<tr>
<td>Missing or failed printhead.</td>
<td>Remove and reinsert the same printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See Replace the printhead on page 61.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The error message does not permit returning to the home screen to start the printhead replacement. Instead, press Show more.</td>
</tr>
<tr>
<td>Refilled or depleted cartridge detected</td>
<td>Check the cartridge.</td>
</tr>
<tr>
<td>Used cartridges might not have enough ink to complete start-up.</td>
<td>A new printhead has been inserted without a new set of ink cartridges. Replace the cartridges not marked as new. See Replace an ink cartridge on page 55.</td>
</tr>
<tr>
<td>Wrong file format.</td>
<td>The file format is incorrect or not supported. The printer cannot process the job, which will be discarded.</td>
</tr>
</tbody>
</table>

### Table 16-2  Numerical error codes

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001-0082</td>
<td>The battery of the real-time clock has expired; contact HP Support. See Contact HP Support on page 101.</td>
</tr>
<tr>
<td>0021-0017</td>
<td>Service station error. There may be a paper or carriage jam. Check and clear the paper path if necessary and restart the printer.</td>
</tr>
<tr>
<td>0041-0017, 0042-0117</td>
<td>There may be a paper or carriage jam. Check and clear the paper path if necessary.</td>
</tr>
<tr>
<td>0085-XXXX</td>
<td>Feeding paper problem. Restart the printer.</td>
</tr>
</tbody>
</table>
HP Customer Care

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing comprehensive, proven support expertise and new technologies to give you unique end-to-end support.

Introduction

Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and self-maintenance services.

To find out more about HP Customer Care, see Contact HP Support on page 101.

To register your warranty, visit http://register.hp.com/.

HP Professional Services

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your HP DesignJet printers and solutions.

HP Support Center

Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access to support.

- Multimedia tutorials
- Step-by-step how-to guides
- Downloads: the latest printer firmware, drivers, software, paper presets, etc.
- Technical support: online troubleshooting, customer care contacts and more
- Workflows and detailed advice for completing various printing tasks from particular software applications
- Forums for direct contact with the experts, both HP and your colleagues
- Warranty tracking online, for your peace of mind
- Latest product information: printers, supplies, accessories, software, etc.
- Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at HP Support Center on page 100.

By customizing your registration for the products you have purchased and your type of business, and by setting your communication preferences, you decide the information you need.

Download printer software

Be sure to follow the software installation instructions.

HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period. They include remote support. On-site service is also provided if necessary, with two alternative response-time options:

- Next business day
- Same business day, within four hours (may not be available in all countries)

There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, visit http://www.hp.com/go/printservices.

HP Installation

The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, visit http://www.hp.com/go/printservices.

Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them.

Using this program, you can replace parts at your own convenience.

Convenient, easy to use

- An HP Support Specialist will diagnose and assess whether a replacement part is required to address a defective hardware component.
- Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact HP.
- Available for most HP products currently under warranty or contract.
- Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support

HP Support is available to you by telephone.

What to do before you call:

- Review the troubleshooting suggestions in this guide.
- Review the relevant driver documentation.
- If you have installed third-party software drivers and RIPs, see their documentation.
- If you call one of the HP offices, please have the following information available to help us answer your questions more quickly:
● The product you are using (the product number and the serial number, found on the label at the back of the product)

● If there is an error code on the front panel, note it down; see Text messages and numerical error codes on page 98.

● The computer you are using

● Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, modems or special software drivers)

● The type of interface used on your product (USB, network, or Wi-Fi)

● The software and driver name and version number that you are currently using

● The Printer Service information:
  ● From the Embedded Web Server:
    In a Web browser, enter your printer’s IP address to access the Embedded Web Server. To access the printer’s service information:
    Tap Product Information ► Printer Information
    Tap Product Information ► Supply Status
    Tap Tools ► Reports ► Usage Report
    Tap Tools ► Reports ► Error Log
  ● From a computer:
    You can print the service information from the front panel:
    Tap then Reports ► Printer Status Report
    Tap then Reports ► Print Quality Report
    Tap then Reports ► Error Log

**Telephone number**

Your HP Support telephone number is available on the Web.
18 Printer specifications

Reference lists of physical, technical, ecological, etc. specifications for your printer.

Functional specifications

Your printer is designed to deliver CAD / construction drawings as well as high quality graphics.

Table 18-1 HP ink supplies

<table>
<thead>
<tr>
<th>Printhead</th>
<th>One printhead</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink cartridges</td>
<td>Cartridges containing 29 ml of ink: yellow, magenta, and cyan</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 38 ml of ink: black</td>
</tr>
<tr>
<td></td>
<td>Cartridges containing 80 ml of ink: black</td>
</tr>
</tbody>
</table>

Table 18-2 Paper sizes

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roll width</td>
<td>279 mm (11 in)</td>
<td>610 mm (24 in) or 914 mm (36 in)</td>
</tr>
<tr>
<td>Roll length</td>
<td>46 m (150 feet)</td>
<td></td>
</tr>
<tr>
<td>Roll diameter</td>
<td>100 mm (3.9 in)</td>
<td></td>
</tr>
<tr>
<td>610 mm (24 in) roll weight</td>
<td>4.1 kg (9 lb)</td>
<td></td>
</tr>
<tr>
<td>914 mm (36 in) roll weight</td>
<td>6.2 kg (14 lb)</td>
<td></td>
</tr>
<tr>
<td>Sheet width</td>
<td>210 mm (8.27 in)</td>
<td>610 mm (24 in) or 914 mm (36 in)</td>
</tr>
<tr>
<td>Sheet length</td>
<td>279 mm (11 in)</td>
<td>1676 mm (66 in)</td>
</tr>
<tr>
<td>Paper thickness</td>
<td>0.3 mm (0.01 in)</td>
<td></td>
</tr>
<tr>
<td>Paper weight</td>
<td>60 g/m²</td>
<td>280 g/m² (220 g/m² in multi-sheet tray)</td>
</tr>
</tbody>
</table>

Table 18-3 Printing resolutions

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum detail</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best (glossy paper*)</td>
<td>On</td>
<td>1200 × 1200</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Best (other papers)</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Normal</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Fast</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Econofast</td>
<td>Off</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
</tbody>
</table>
* For a list of supported glossy papers, see Order paper on page 67.

Table 18-4 Margins

<table>
<thead>
<tr>
<th>Margin Type</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top left and right</td>
<td>5 mm (0.2 in)</td>
</tr>
<tr>
<td>Bottom</td>
<td>17 mm (0.67 in)</td>
</tr>
</tbody>
</table>

Table 18-5 Mechanical accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing material in Best or Normal mode with HP Heavyweight Coated Paper roll feed.

Table 18-6 Graphic languages supported

<table>
<thead>
<tr>
<th>HP DesignJet</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>T200 Printer Series</td>
<td>HP PCL3GUI</td>
</tr>
<tr>
<td>T600 Printer Series</td>
<td>HP PCL3GUI, HP-GL/2 and HP RTL (Windows)</td>
</tr>
</tbody>
</table>

Mobile Printing specifications

Easy wireless printing from your iPad, iPhone, Android, or other device.

Table 18-7 Mobile printing

<table>
<thead>
<tr>
<th>Mobile printing</th>
<th>Yes, directly from both iOS with AirPrint and Android with HP Print Service Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices supported by HP Mobile printing</td>
<td>Smartphones and tablets</td>
</tr>
<tr>
<td>Supported operating systems</td>
<td>iOS, Android</td>
</tr>
<tr>
<td>OS versions</td>
<td>iOS from 7.0 and Android from 4.4</td>
</tr>
<tr>
<td>Connectivity requirements</td>
<td>Printer and mobile device must use the same network, or have internet connection if in different networks</td>
</tr>
<tr>
<td>Supported file formats</td>
<td>PDF, JPEG</td>
</tr>
</tbody>
</table>

Table 18-8 HP Smart App

<table>
<thead>
<tr>
<th>Software</th>
<th>HP Smart App</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices supported</td>
<td>Smartphones, tablets, PC</td>
</tr>
<tr>
<td>Operating systems supported</td>
<td>iOS from 11, Android from 5.0, Windows from 8.1, macOS from 10.11</td>
</tr>
<tr>
<td>Connectivity requirements</td>
<td>Printer and mobile device must use the same network, or have internet connection if in different networks</td>
</tr>
<tr>
<td>File formats supported</td>
<td>PDF, JPEG, webpages, email attachments, Microsoft Office documents</td>
</tr>
</tbody>
</table>
### Table 18-9 Email printing

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile devices supported</td>
<td>Smartphones, tablets, PC</td>
</tr>
<tr>
<td>Supported operating systems</td>
<td>Any, as long as it has email</td>
</tr>
<tr>
<td>Connectivity requirements</td>
<td>Cloud connection</td>
</tr>
<tr>
<td>Cloud features</td>
<td>Remote printing through email</td>
</tr>
<tr>
<td>Supported file formats</td>
<td>PDF</td>
</tr>
<tr>
<td>Max file size</td>
<td>10 MB</td>
</tr>
</tbody>
</table>

### Physical specifications

Each model has distinct specifications along with some things in common.

### Table 18-10 Printer physical specifications

<table>
<thead>
<tr>
<th></th>
<th>HP DesignJet T200 Printer series</th>
<th>HP DesignJet T600 24-in</th>
<th>HP DesignJet T600 36-in</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weight</strong></td>
<td>21.5 kg (47.4 lb)</td>
<td>30.5 kg (66.1 lb)</td>
<td>36.6 kg (80.7 lb)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>with all the accessories installed</td>
<td>with all the accessories installed</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>1013 mm (39.9 in)</td>
<td>1013 mm (39.9 in)</td>
<td>1317 mm (51.8 in)</td>
</tr>
<tr>
<td><strong>Depth</strong></td>
<td>404 mm (15.9 in)</td>
<td>512 mm (20.1 in)</td>
<td>512 mm (20.1 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>without stand</td>
<td>without stand</td>
</tr>
<tr>
<td></td>
<td></td>
<td>605 mm (23.8 in) with stand</td>
<td>605 mm (23.8 in) with stand</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>285 mm (11.2 in)</td>
<td>293 mm (11.5 in)</td>
<td>293 mm (11.5 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>without stand</td>
<td>without stand</td>
</tr>
<tr>
<td></td>
<td></td>
<td>932 mm (36.7 in) with stand</td>
<td>932 mm (36.7 in) with stand</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1110 mm (43.7 in) with stand and multi-sheet tray extended</td>
<td>1110 mm (43.7 in) with stand and multi-sheet tray extended</td>
</tr>
</tbody>
</table>

### Memory specifications

The memory allocated to your printer depends on the model.

### Table 18-11 Memory specifications

<table>
<thead>
<tr>
<th>Printer</th>
<th>Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP DesignJet T200 Printer series</td>
<td>512 MB</td>
</tr>
<tr>
<td>HP DesignJet T600 Printer series</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

### Power specifications

Use the electrical cord supplied with the printer and the power supply voltage specified on the label. Avoid overloading the printer’s electrical outlet with multiple devices.
### Table 18-12 Printer power specifications

<table>
<thead>
<tr>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>100–240 V ac ±10%, auto-ranging</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Maximum current</td>
<td>1200 mA</td>
</tr>
<tr>
<td>Average consumption</td>
<td>35 W</td>
</tr>
</tbody>
</table>

### Ecological specifications

This product complies with the WEEE Directive 2002/96/EC and RoHS Directive 2002/95/EC.

To determine the ENERGY STAR qualification status of these product models see [http://www.hp.com/go/energystar](http://www.hp.com/go/energystar).

### Environmental specifications

Recommended operating and storage temperature and humidity.

### Table 18-13 Printer environmental specifications

<table>
<thead>
<tr>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>5 to 40°C (41 to 104°F)</td>
</tr>
<tr>
<td>Recommended operating temperature</td>
<td>15 to 35°C (59 to 95°F), depending on paper type</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>–25 to 55°C (–13 to 131°F)</td>
</tr>
<tr>
<td>Recommended operating humidity</td>
<td>20 to 80% RH, depending on paper type</td>
</tr>
<tr>
<td>Storage humidity</td>
<td>0 to 95% RH</td>
</tr>
<tr>
<td>Maximum altitude when printing</td>
<td>3000 m (9850 ft)</td>
</tr>
</tbody>
</table>

### Acoustic specifications

Declared noise emission levels for the HP DesignJet T200/T600 Printer series. Sound Pressure Levels at bystander positions and Sound Power Levels have been measured.

### Table 18-14 Printer acoustic specifications

<table>
<thead>
<tr>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Idle sound power</td>
<td>&lt; 3.4 B (A)</td>
</tr>
<tr>
<td>Operating sound power</td>
<td>5.8 B (A)</td>
</tr>
<tr>
<td>Idle sound pressure</td>
<td>&lt; 16 dB (A)</td>
</tr>
<tr>
<td>Operating sound pressure</td>
<td>42 dB (A)</td>
</tr>
</tbody>
</table>
**AirPrint**
Apple technology that helps you create full-quality printed output without the need to download or install drivers.

**Bonjour**
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area network. It was originally known as Rendezvous.

**Color accuracy**
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

**Color consistency**
The ability to print the same colors from a particular print job from print to print and from printer to printer.

**Color model**
A system of representing colors by numbers, such as RGB or CMYK.

**Color space**
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

**Cutter**
A printer component that slides back and forth across the platen to cut the paper.

**ESD**
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

**Ethernet**
A popular computer networking technology for local area networks.

**Fast Ethernet**
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

**Firmware**
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

**Gamut**
The range of colors and density values reproducible on an output device, such as a printer or monitor.

**Hi-Speed USB**
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with original USB. Most personal computers today use Hi-Speed USB.
HP RTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Network
A network is a set of connections that pass data between computers and devices. Every device is able to communicate with every other device in the same network. This allows data to be moved between computers and devices, and allows devices such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it on the paper, through a cluster of nozzles.
Spindle
A rod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed USB (sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, through which a computer can control the device. For a computer to print to your printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those found on computers. A printer can control USB devices that are connected to such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.

WiFi
This term is used for any wireless local area network products that are based on the Institute of Electrical and Electronics Engineers' (IEEE) 802.11 standards.
Index

| A | access control 19 |
|   | accessories       |
|   | introduction 68   |
|   | order 67, 68      |
|   | acoustic specifications 106 |
|   | Acrobat Pro, print 44 |
|   | Acrobat Reader, print 44 |
|   | Acrobat, print 43 |
|   | Acrobat, print multipage 43 |
|   | advanced print settings 37 |
|   | alerts            |
|   | errors 97         |
|   | turn on and off 17 |
|   | warnings 97       |
|   | auto-off 21       |
|   | AutoCAD, print presentation 50 |
|   | automatic firmware update, configure 17 |
|   | automatic sheet feeder 68 |
| B | banding problems 64 |
|   | bin               |
|   | output problems 77 |
|   | black and white 42 |
|   | brightness in front panel 22 |
| C | care of the printer 58 |
|   | clean the encoder strip 63 |
|   | clean the platen 84 |
|   | clean the printer 58 |
|   | clipped at bottom 86 |
|   | clipped image 86 |
|   | color             |
|   | fading 86         |
|   | inaccurate 85     |
|   | color management 41 |
|   | options 42        |
|   | printing grayscale 42 |
|   | computer communication |
|   | printer/computer communications issues 89 |
|   | configure firewall settings 23 |
|   | change options 23 |
|   | change the priority of rules 23 |
|   | create a firewall rule 23 |
|   | creating and using rules 23 |
|   | limitations 24     |
|   | reset network settings 24 |
|   | reset settings 24   |
|   | configure the power button 21 |
|   | connect the printer (Windows USB) 15 |
|   | sharing considerations 15 |
|   | connect the printer mac os x add your printer 15 |
|   | custom paper sizes 38 |
|   | Customer Care 100  |
|   | Customer Self Repair 101 |
|   | cutter on/off 31   |
| D | download printer software 100 |
|   | draft printing 40  |
|   | driver preferences 19 |
|   | drying time change 31 |
| E | ecological specifications 106 |
|   | economize on ink 41 |
|   | on paper 41        |
|   | email notifications 17 |
|   | email printing, enable 11 |
|   | Embedded Web Server access 20 |
|   | cannot access 96   |
|   | language 20        |
|   | enable email printing 11 |
|   | environmental specifications 106 |
|   | error messages     |
|   | front panel 98     |
| F | fading colors 86   |
|   | features of printer 4 |
|   | firmware update 65 |
|   | configure automatic 17 |
|   | front panel 8      |
|   | brightness 22      |
|   | dashboard icons 8   |
|   | dynamic icons 9     |
|   | fixed icons 9       |
|   | frozen 96          |
|   | language 20        |
|   | front panel option |
|   | align printhead 60 |
|   | auto-off 21        |
|   | calibrate ready paper 64 |
|   | clean printhead 59, 60 |
|   | display brightness 22 |
|   | enable cutter 31   |
|   | firmware update 65 |
|   | form feed 32       |
|   | form feed and cut 32 |
|   | print diagnostic image 58, 59 |
|   | replace printhead 61 |
|   | reset ready paper 64 |
|   | reset ready paper calibration 64 |
|   | select drying time 31 |
|   | select I/O timeout 86 |
|   | select language 20 |
|   | sleep 21           |
|   | unload roll 28     |
|   | front view T600 printer series 4 |
|   | frozen front panel 96 |
|   | functional specifications 103 |
| G | graphic languages 103 |
|   | gray shades 42     |
|   | grayscale 42       |
H

H
dard disk specification 105
HP Care Packs 101
HP Click 36
HP Customer Care 100
HP Installation 101
HP Support 101
HP support assistant 66
HP Support Center 100
HP Utility
access 21
language 21

I

I
image problems
cropped at bottom 86
cropped image 86
missing objects 87
ink
economical use of 41
ink cartridge
about 54
cannot insert 88
memory chip 54
order 67
replace 55
specification 103
status 54
status messages 88
ink cartridge; usage information 54
IP address 20
static 89
use hostname 89

L

L
language 20
load paper
general advice 26
multi-sheet tray 29
paper not in driver 71
roll cannot load 69
roll into printer 27
roll onto a spindle 26
sheet cannot load 69
sheet cannot load from tray 70
single sheet 28

M

M
maintenance kits 65
margins 39
specification 103

mechanical accuracy 103
memory specifications 105
Microsoft Office, print 52
misaligned colors 80
mobile printing 33
introduction 11
troubleshooting 93
mobile specifications 104
models, printer 3
move or store the printer 65

N

N
network
configuration page 93
wireless issues 90
network settings 22
network troubleshooting, wired 90

O

O
order
accessories 67, 68
ink cartridges 67
paper 67
printhead 67

P

P
page size 37
paper
advance 32
calibrate the paper advance 64
custom paper size 38
cut after printing 78
economical use of 41
form feed 32
form feed and cut 32
incorrect out of paper 77
jam due to cut strip 77
loading error messages 71
maintenance 31
mismatch 73
multi-sheet tray has jammed 75
not cut well 78
output problems in bin 77
paper not in driver 71
prevent a jam 74
print on loaded paper 39, 72
printed on wrong paper 72
retained by printer 77
roll has jammed 73
roll loose on spindle 78
select type 39
size 37
sizes (max and min) 103
view information 30
paper cannot be loaded 69
paper not in driver 71
paper types 67
Photoshop, print 44
Photoshop, print presentation 50
physical specifications 105
platen cleaning 84
power
on/off 7
power specifications 105
preferences, Windows driver 19
preview a print 40
print from mobile 33
print from Android 33
print with AirPrint 33
print with HP Smart App 33
print preview 40
print quality
select 37
print quality diagnostic report 58, 59
print using printer driver 37
print-quality problems
black ink comes off 84
blurred lines 81
blurry or grainy image 82
different colored vertical lines 85
discontinuous lines 81
dark edges than expected 85
dark edges stepped or not sharp 84
general 79
horizontal lines 79
inaccurate colors 85
inaccurate line length 82
ink marks 84
ink marks 84
misaligned colors 80
paper not flat 83
scratching 83
scuffing 83
stepped or jagged lines 80
thick, thin, or missing lines 80
white spots 85
printer

does not print 95
does not start 95
download software 100
main features 4
models 3

ENWW

Index 111
security 24
solutions 9
status 58
printhead
   about 56
cannot insert 88
clean; purge 59
order 67
   specification 103
printhead cleaner
   specification 103
printing resolutions 103

Q
quality, high 41

R
rear view T200 printer series 6
rear view T600 printer series 5
replace an ink cartridge 55
replace printhead 61
reports 11
rescale a print 39
restore factory
   defaults 96
   settings 96
roll cover 68
roll paper
   unload 28

S
safe mode 56
safety precautions 1
scale a print 39
scratched prints 83
scuffed prints 83
security 19
sheet paper
   unload 29
sleep mode wait time 21
slow printing 95
software
   download 100
   install (Mac OS X) 15
   install (Windows) 15
   update 65
solutions 9
specifications
   acoustic 106
   ecological 106
   environmental 106

T
telephone number 101, 102

U
unload paper
   roll 28
   sheet 29
usage information stored in
cartridge 54
using this guide 2
using Wi-Fi direct 34
   change connection method 35
   guidelines for using 34
   turn on 35
   with mobile that doesn’t support 36
   with mobile that supports 35
   with wireless-capable computer
      (Windows) 36

W
warranty extensions 101